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Introduccion

iBienvenidos a Flame Painter 4!

Flame Painter es un software Unico independiente de efectos de pintura y particulas que le
permite crear facilmente obras de arte originales, efectos de luz, disefio poco convencional o
fondos fantasticos. Este software carga las posibilidades de la pintura digital y mejora los
disefios y fotografias con pinceles orgdnicos. La tecnologia de ultima generacién de Flame
Painter le permite crear espectro ilimitado de pinceles orgéanicos, que van desde clasicos
efectos de luz a patrones estructurados, formas texturadas o incluso pinceles de pintura
natural.

Fue creado como un proyecto experimental en mi serie ‘Yo soy un artista’. La visidn inicial era
crear una aplicacién en la que cualquier persona podria crear algo hermoso. Fue hecho tanto
como una herramienta para los artistas, asi como para las personas sin habilidades artisticas

gue quieren crear algo Unico.

Flame Painter 4 presenta las primeras innovaciones de la industria, como nuevos sistemas de
particulas, pinceles con personalizacién ilimitada y nuevas opciones para capas vectoriales
ideales para perfeccionar una amplia gama de proyectos, desde composicién de arte digital
hasta fotografia o cualquier lugar donde desee que sus cosas se vean geniales. Esta version
también presenta herramientas que hacen que trabajar con Flame Painter sea alin mas
productivo: Creador de Pinceles avanzado, herramienta de simetria, plug-in para Photoshop y
soporte completo para gestos multitactiles. Los artistas y disefiadores definitivamente
aprovecharan el nuevo panel de navegacion, los nuevos filtros, la herramienta de seleccién y
tamano de lienzo o el panel de paleta avanzado.

En este manual encontrara informacién general sobre todos los detalles que necesita saber
para un uso de este software. Hemos preparado las explicaciones de sus caracteristicas,
indicios Utiles y antecedentes técnicos de Flame Painter para ustedes.

iGracias por comprar Flame Painter, espero que pase gran tiempo con la pintura!

Peter Blaskovi¢
creador de Flame Painter
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Empezamos

Instalar y Registrar Flame Painter

Descargar & Instalar

Después de comprar Flame Painter, serd redirigido a una pagina en la que cree una cuenta de
Comunidad ingresando su nombre de usuario Unico y contrasefa. Esta cuenta de Comunidad
servird para registrar su licencia de Flame Painter. También recibira un correo electrénico con
un enlace para descargar.

Usuarios de Mac OS X
Descarga un archivo .dmg del enlace que aparece en un correo electrénico. Localice el archivo

de instalacion de Flame Painter llamado "Flame Painter 4.dmg". Haga doble clic en el archivo
de instalacion para completar la instalacion.

Usuarios de Windows

Descarga un archivo .exe para el sistema 32 o 64-bit del enlace que aparece en un correo
electrénico. Localice el archivo de instalacién de Flame Painter llamado "Flame Painter 4.exe".
Haga doble clic en el archivo de instalacidén .exe para completar la instalacidn.

Registrar

Introduzca su correo electrénico y contrasefia de su cuenta de Comunidad.

Por favor compruebe si esta conectado a Internet. Se requiere la conexion a Internet para la
activacion para comprobar los datos de registro.

Requisitos del Sistema

Windows 10, 8, 7 con procesador Intel Pentium 4, Mac OS X 10.11 o mas nuevo con procesador
Intel, tarjeta gréfica OpenGL 2.0, 4GB de RAM, espacio de disco duro de 100MB.

Soporte de tableta
Cuando Flame Painter se inicie por primera vez se le pedira que seleccione el dispositivo de

tableta preferido: compatible con Wacom o compatible con Microsoft Ink. Puede cambiar las
opciones de tableta en cualquier momento en Preferencias > Tableta.



Idiomas

Flame Painter esta disponible en diferentes idiomas. Puede seleccionar el idioma de la interfaz
de Flame Painter a través del menu Ayuda > Idioma (Help > Language). Tiene que reiniciar
Flame Painter para aplicar estos cambios.

Obtener Soporte para Flame Painter

Si necesita ayuda para utilizar Flame Painter en primer lugar consulte este manual incluido.
Hemos intentado hacerlo facil para leer y lleno de informacién que necesita saber.

Le invitamos a enviarnos un correo electrdnico a support@escapemotions.com si usted tiene

cualquier pregunta, problema técnico con Flame Painter o le gustaria simplemente para
saludarnos.

Antes de hacer preguntas por favor visite el foro de Escape Motions Comunidad
escapemotions.com/community. Si la respuesta no esta ahi por favor agrega la configuracion

de su equipo a su correo electrénico (Windows / Mac OS, 32 / 64 bits del sistema operativo,
procesador, tarjeta grafica, memoria). Esto nos ayudara a proporcionar respuestas mucho mas
rapido.

Comunidad

Le invitamos a visitar la Comunidad de Escape Motions donde puede participar en la discusion
sobre el software, obtener consejos y trucos, compartir sus comentarios, crear su propio
portafolio, publicar en Galeria o descargar recursos.

Para iniciar sesidén en la Comunidad, use su cuenta de Comunidad.

Sigamos en contacto en nuestros canales sociales también - haga clic en cualquier icono y
visitar nuestras pdaginas en Facebook, Instagram, Twitter, Pinterest, Tumblr, YouTube,
DeviantArt y Behance.

HECENE
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Interfaz de Flame Painter

Background

HEE®

1 - Barra de Menu (Menu Bar)

2 - Panel de Herramientas (Tools Panel)

3 - Panel de Propiedades (Properties Panel)

4 - Panel de Pinceles (Brushes Panel)

5 - Panel de Creador de Pinceles (Brush Creator Panel)

6 — Panel de Herramienta Regla / Perspectiva (Ruler / Perspective Tool)
7 - Panel de Navegador (Navigator Panel)

8 - Panel de Paleta (Palette Panel)

9 - Panel de Capas (Layers Panel)

SUGERENCIA: Todos los paneles son acoplables - es posible modificar, cambiar la posicion y
ajustar la anchura de los paneles. Los paneles ocultan mientras que se pinta en el lienzo detrds
de ellos.

SUGERENCIA: Puede guardar disefios personalizados de la interfaz de Flame Painter a través del
menu Ventana > Exportar Disefio (Window > Export Layout). Para abrir el disefio previamente
guardado, seleccione "Importar Disefio" en el menu Ventana.



Panel de Herramientas

f Pincel - Seleccione la herramienta Pincel.
£ Pluma - Seleccione la herramienta Pluma.
o Borrador - Seleccione la herramienta Borrador.

.6 Relleno - Seleccione la herramienta Relleno.

‘d
7 Escoger Color - Seleccione la herramienta para
escoger el color del lienzo.
’l M . . . . . .
**“ Editar Capa Vectorial - Seleccione la herramienta para editar capas vectoriales.

qap
¢ Simetria - Seleccione la herramienta Simetria para patrones de simetria. Cuando el modo

4p
Simetria estd activo, el icono cambia a "+,

FELYY

i... Seleccién - Seleccione y marque dreas del lienzo para realizar operaciones en esta drea
seleccionada.

% Transformar - Seleccione la herramienta Transformar para mover, cambiar tamafio,
escalar, rotar o voltear la capa seleccionada.

ul Tamaio de Lienzo - Seleccione esta herramienta para cambiar el tamafio, escalar o
recortar el lienzo.

O Deshacer - Deshace la tltima operacion de pintura que ha realizada.

C Rehacer - Rehace la tltima operacion de deshacer.

— Contraer Panel - Contraiga el Panel de Herramientas. Este botdn estd presente en todos los
paneles de la interfaz de Flame Painter.

= Menu de Panel de Herramientas: Seleccione para cerrar el panel. Es posible mostrar el
panel de nuevo desde el Menu de Ventana (Window menu).



Panel de Propiedades

Este panel contiene ajustes de la herramienta seleccionada.

= Men de Panel de Propiedades:

- Paleta y Forma Global - Al cambiar entre sistemas de particulas, la paleta y la forma de pincel
seleccionadas actualmente se utilizardn en cada sistema de particulas.

- Actualizar Particulas Solo en Movimiento - Seleccione esta opcidn para actualizar la posicidn
del particulas solo con el movimiento del ratén o del stylus.

- Cerrar - Cierre el panel. Es posible mostrar el panel de nuevo desde el menu Ventana
(Window Menu).

Propiedades de Herramienta Pincel

Hay seis sistemas de particulas: Flame, Ribbon, Follow,

Flame Get more...

Liner, Fuzzy vy Elastic.

Size 50

Blending |Normal Tres sistemas de particulas se incluyen en el paquete
Opacity de instalacion: Flame, Ribbon y Follow y tres estan
disponibles para descargar: Liner, Fuzzy y Elastic.

Lines Count

Lines Width

Flame - El sistema de particulas clasico.

Ribbon - El sistema de particulas de ribbon.

Follow - El trazo sigue al cursor con mayor precision.
Liner - Sistema de particulas de pincel basado en
lineas.

Elastic - Sistema de particulas versatil con cursor de

pincel el3stico.
Fuzzy - Sistema de particulas basado en cuerdas.

Obtener mas... - Visite nuestro sitio web para obtener mas sistemas de particulas:
http://www.escapemotions.com/shop

Sistemas de particulas Liner, Fuzzy y Elastic son parte del modo especial en Flame Painter -
puede probar todos sus controles y opciones visuales en una "Capa de vista previa".
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Abra las opciones de Suavizado:
Posicidn - Establezca el suavizado de la posicidn del cursor tanto para

Smoothing

el mouse como para el stylus. Cuando se establece en el valor
Position WAL T S
Max.", el cursor seguira mas suavemente.
Pen Pressure Presion de Stylus - Establezca el suavizado de la presién para el
stylus. Cuando se establece en el valor "Max", las transiciones de
Pen Sensitivity presion en el trazo seran mas suaves.
Soft Firm Sensibilidad de Stylus - Establezca el suavizado de la curva de

sensibilidad a la presion para el stylus. Cuando se establece en

"Suave", se requiere menos presion, cuando se establece en "Firme"
se requiere mas presion.

Las propiedades de la herramienta Pincel contienen la configuracién mas utilizada para cada
pincel en el sistema de particulas:

Tamaino - Ajuste el tamario del pincel.

Fusidn - Modo de fusidn de color. Hay tres modos:

- Normal para pintura regular,

- Aclarar es generalmente para los efectos de luz y los fondos oscuros y
- Oscurecer para los fondos mas claros.

Opacidad - Opacidad del pincel (1-100).

Segun el perfil de forma que tenga el pincel seleccionado, estas configuraciones estan
disponibles:

Numero de Lineas - Establezca el nimero de lineas en el pincel de Linea y Linea Punteada (1-
100).

Anchura de Lineas - Establezca la anchura de lineas en el pincel de Linea y Linea Punteada (1-
100).

Tamaiio de Puntos - Establezca el tamafio de puntos en el pincel de Linea Punteada (1-100).

La herramienta Pincel tiene varios ajustes preestablecidos de pincel disponibles en el panel
Pinceles. Puede crear sus propios ajustes preestablecidos de pincel utilizando el panel Creador

de Pinceles. Muestre u oculte este panel utilizando el botén == en la esquina inferior izquierda
del panel Propiedades o mediante el menu Ventana.

Puede encontrar mas informacion sobre cémo crear pinceles personalizados en la seccién
Panel de Creador de Pinceles.

11



Blending [Normal

Size
Opacity
Hardness

Spacing

Size
Opacity
Hardness

Spacing

Propiedades de Herramienta Pluma

Herramienta de pintura basica con los siguientes
parametros:

Fusién - Modo de fusion de color. Hay tres modos:
Normal, Aclarar y Oscurecer.

Tamaiio - Ajuste el tamafio de la Pluma (1-500).
Opacidad - Opacidad de la Pluma (1-100).

Dureza - Establezca la dureza de la Pluma (0-100).
Espaciado - Establezca el espacio entre los marcas del
pincel de la Pluma (1-100).

Propiedades de Herramienta Borrador

Tamano - Ajuste el tamafio del Borrador (1-500).
Opacidad - Opacidad del Borrador (1-100).

Dureza - Establezca la dureza del Borrador (0-100).
Espaciado - Establezca el espacio entre los marcas del
Borrador (1-100).

SUGERENCIA: Puede ajustar la punta del borrador de
un ldpiz de tableta grdfica a borrador via
“Preferencias -> Herramientas (mantener)” /
“Preferences -> Tools (hold)”.

Seleccione “Borrador” y lo ajuste al “Ldpiz (Borrador)”
en la parte inferior de la ventana.
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Propiedades de Herramienta Relleno

Opacity . .
Se puede rellenar el lienzo y los trazos ya pintados

Tolerance O con color o gradiente basado en el color y el tono de

B Antialiasing
] Contiguous
[] Use Alpha

los pixeles en los que hace clic.

Puede especificar cualquiera de los siguientes:

- Opacidad - Establezca la opacidad del color o gradiente (1-100).

- Tolerancia - Determina la gama de colores de los pixeles seleccionados. Introduzca un valor
en pixeles, entre 0 y 255. El valor O significa que solo se seleccionardn y llenaran los pixeles que
son del mismo color que el pixel especifico en el que hizo clic. El valor mayor que 0 representa
los tonos de pixeles mas oscuros y claros que se seleccionardn y llenaran también.

- Suavizado - Crea una seleccion de bordes mas suaves.

- Contiguo - Selecciona solo zonas adyacentes con los mismos colores. De lo contrario, se
seleccionan y llenan todos los pixeles de la imagen completa con los mismos colores.

- Usar Alpha - Determina el canal alfa de los pixeles seleccionados.

La capa o seleccion se llena con el color o el gradiente seleccionado en el panel Paleta. Si elige

el gradiente, puede llenar la capa con gradiente vertical u horizontal. También puede
establecer cudntas veces se debe repetir el gradiente.

Propiedades de Herramienta Escoger Color

Sample: . .
2 Esta herramienta le permite escoger color de la capa o
Sample Size: (@ capas.
Muestra:

~ Capa Actual - El color se escogi6 sélo de una capa
activa.

= Todas Capas - El color se escogio de todas las
capas.

Tamaiio de Muestra - El tamafio promedio de la
muestra.
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) > . .
% 7 Cuando la herramienta Escoger Color se selecciona el

. Newco(%: cursor cambia a un circulo con tres zonas de colores
y # A Color diferentes:
A Color Nuevo (New Color) - El color seleccionado
Original nuevo.
color Muestra de Color (Sample) - El color del lienzo debajo
£ del disco.

Color Original - El color seleccionado.

Edit Vector Layer Propiedades de Herramienta Editar Capa Vectorial

Particle System » . . . L
Capas vectoriales tienen una gran ventaja de edicion

Flame » Get more...

adicional de los trazados pintados. En |la capa vectorial
Size 50 se puede pintar un trazo que se puede, ademas,
Blending |Normal transformar y editar. Después de pintar una pincelada,
Opacity se puede cambiar el sistema de particulas, cualquier
parametro de pincel, modo de fusién, la opacidad,
paletas del color y del gradiente o cambiar todo el
pincel preestablecido para otro.

Lines Count
Lines Width

Edit Path Es el modo de edicidon muy flexible que si usted desea,
At ademas, puede equilibrar los parametros para
establecer la forma del major pincel.

Sistema de Particulas - Cambie el sistema de particulas del trazo vectorial.
Obtener mas... - Visite nuestro sitio web para obtener mas sistemas de particulas:
http://www.escapemotions.com/shop
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Edite las opciones de Suavizado:
Posicion - Establezca el suavizado de la posicién del cursor tanto para
othing el mouse como para el stylus. Cuando se establece en el valor "Max.",
Position el cursor seguird mas suavemente.
Ben Pressure Presion de Stylus - Establezca el suavizado de la presion para el stylus.
Cuando se establece en el valor "Max", las transiciones de presién en

el trazo seran mas suaves.

Pen Sensitivity
Soft Firm Sensibilidad de Stylus - Establezca el suavizado de la curva de

sensibilidad a la presiéon para el stylus. Cuando se establece en
"Suave", se requiere menos presidn, cuando se establece en "Firme"
se requiere mas presion.

Tamaifio - Ajuste el tamafo del pincel.

Fusidn - Modo de fusién de color. Hay tres modos:

- Normal para pintura regular,

- Aclarar es generalmente para los efectos de luz y los fondos oscuros y
- Oscurecer para los fondos mas claros.

Opacidad - Opacidad del pincel (1-100).

Segun el perfil de forma que tenga el pincel seleccionado, estas configuraciones estan
disponibles:

Numero de Lineas - Establezca el nimero de lineas en el pincel de Linea y Linea Punteada (1-
100).

Anchura de Lineas - Establezca la anchura de lineas en el pincel de Linea y Linea Punteada (1-
100).

Tamano de Puntos - Establezca el tamafio de puntos en el pincel de Linea Punteada (1-100).

Los controles Editar Trazo incluyen:

Herramienta Editar - Editar vértices claves y modificar el vector creado. Haga clic en vértices
para cambiar a vértices claves.

Herramienta Editar Grupo - Editar grupo de vértices.

Herramienta Agregar y Eliminar - Retire vértices editables desde el trazo (atajo: Ctrl en
Windows / Cmd en Mac OS).

Transformar Curva Inicial - Cambiar el tamaiio, rotar y escalar una curva inicial del trazo.

NOTA: Por favor tenga en cuenta que después de crear un nuevo trazo en una capa vectorial, el
anterior se borra. La creacion de una nueva capa vectorial para cada trazo editable se
recomienda.
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Propiedades de Herramienta Simetria

Symmetry

[] Use Symmetry

La herramienta de simetria le permite pintar
simétricamente con la herramienta Pincel.

Usar Symetria - Active o desactive la simetria. Cuando el modo Simetria esta activo, el icono
ap 4
cambia de &' a ",

Rotacional - Establezca el nUmero de lineas de simetria (0-8).
De espejo - Active o desactive la simetria de espejo.

Selection Propiedades de Herramienta Seleccion

=1 e
' e
'

o0 *, P
. t\:J '._.." /‘
ol L=l i

Seleccione un area especifica del lienzo y realice
operaciones en este area seleccionada.

Hay cinco tipos de herramienta Seleccién disponibles:

r--

:__i Rectangulo - Cree selecciones rectangulares
haciendo clic y arrastrando sobre el lienzo.

.. Elipse - Cree selecciones elipticas haciendo clic y arrastrando sobre el lienzo.

Utilice el atajo Shift para escalar la seleccién rectangular o eliptica proporcionalmente.

Utilice el atajo Alt para escalar la seleccién en relacién a su centro.

Utilice el atajo Shift para habilitar la rotacién en angulos de 15 grados. Puede cambiar el angulo
predeterminado en el panel Preferencias > Herramientas, en "Transformacién".

o Poligono - Cree selecciones poligonales. Haga clic para colocar un punto de seleccion,
suelte el botdn del ratdn y haga clic para colocar el punto siguiente. Para terminar creacién de
la seleccién poligonal haga clic en el primer punto de nuevo o presione Enter - el Ultimo punto
se vinculara automaticamente al primer punto. Use Backspace para deshacer el dltimo punto
gue ha creado.

Use Esc para eliminar la seleccidn aun no confirmada.

16



NOTA: Confirme la seleccion rectangular, eliptica y poligonal pulsando Enter o haciendo clic en
la ventana grdfica fuera de la drea seleccionada.

*.-’ A Mano Alzada - Cree selecciones a mano alzada dibujando un contorno alrededor del 4rea
gue desea seleccionar. Cuando se suelta el ratén el final de la linea se conectara
automaticamente a su inicio.

ale

#”* Varita Magica - Crea selecciones basadas en el tono y el color de los pixeles. Puede
especificar cualquiera de los siguientes:

- Tolerancia - Determina la gama de colores de los pixeles seleccionados. Introduzca un valor
en pixeles, entre 0 y 255. El valor O significa que solo se seleccionaran los pixeles que son del
mismo color que el pixel especifico en el que hizo clic. El valor mayor que 0 representa los
tonos de pixeles mas oscuros y claros que se seleccionaran también.

- Suavizado - Crea una seleccion de bordes mas suaves.

- Contiguo - Selecciona solo zonas adyacentes con los mismos colores. De lo contrario, se
seleccionan todos los pixeles de la imagen completa con los mismos colores.

- Usar Alpha - Determina el canal alfa de los pixeles seleccionados.

Hay tres modos de cdmo una nueva seleccién se afiade a cualquier seleccién actual en el
lienzo:

N Seleccidon Nueva - Sustituya la seleccion actual por la nueva seleccidn.

‘ Ainadir a Seleccidn - Anada una nueva seleccion a la seleccidn actual para crear un nuevo
resultado. (Atajo: Shift).

tl Restar de la Seleccidn - Reste el drea de la nueva seleccién de la seleccidn actual para crear
un nuevo resultado. (Atajo: Alt).

l:l Invertir Seleccidn - Invierta la seleccidn actual. (Shortcut Ctrl + Shift + 1 / Cmd + Shift + 1).

] Seleccionar Todo - Seleccione el contenido de la capa actual. Puede seleccionar todo
también utilizando atajo Ctrl + A/ Cmd + A o a través del menu Editar -> Seleccionar Todo.

D Deseleccionar Todo - Anule la seleccidn actual. Puede deseleccionar todo también
utilizando atajo Ctrl + D / Cmd + D o a través del menu Editar -> Deseleccionar Todo.

Puede encontrar mas informaciéon sobre cdmo usar las selecciones en Flame Painter en la
seccion Trabajar con Selecciones.

NOTA: Las selecciones solo funcionan en capas de mapa de bits, no en capas vectoriales.
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Transform Propiedades de Herramienta Transformar

pXx
)4

Transforme la capa o capas seleccionadas y su
posicion.

)4

= X - Ajuste la posicion X de la capa.

Y - Ajuste la posicion Y de la capa.
Cuando ambas posiciones se establecen a 0, la capa
se transforma al lado izquierdo y superior del lienzo.

Anchura - Ajuste la anchura de la capa.
Altura - Ajuste la altura de la capa.
Angulo - Ajuste el dngulo de la rotacion.

il . .
= Voltear Verticalmente - Voltee la capa verticalmente.

A Voltear Horizontalmente - Voltee la capa horizontalmente.

La siguiente imagen muestra cémo utilizar la Herramienta Transformar con el ratdn, stylus de
la tableta y el toque:

Ry i 2
et o ol
Use two fingers Use mouse, finger
to transfer ar pen to transfer
the layer the layer
2 (jm
\[ = Q O =
& Move o o o)
& Rotate  Scale i R

Mover - Mueve una capa transformada o capas seleccionadas.

Escalar - Escale para aumentar o reducir una capa transformada en relacién a su esquina
superior izquierda. Puede escalar una capa horizontalmente, verticalmente o ambos. Utilice
teclado Shift para escalar proporcionalmente. Utilice teclado Alt para escalar una capa con
respecto a su centro.
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Rotar - Herramienta rote una capa o capas transformadas alrededor de su centro. Utilice
teclado Shift para bloquear la rotacién en angulos de 15 grados. Puede cambiar el angulo
predeterminado en Preferencias > Herramientas > Transformacion.

Mueve, escale y rote con ratén, stylus o con el toque. Utilice dos dedos para mover, rotar y
escalar la capa o capas simultdneamente. Mds informacidn sobre el soporte tactil en Flame
Painter se puede encontrar en la seccion Soporte Multitactil.

SUGERENCIA: Puede desactivar la capacidad de "Usar dos dedos para rotar el lienzo" en
Preferencias -> Tableta -> Opciones de tableta. Todavia podrd mover o escalar lienzo usando
dos dedos después.

Propiedades de Herramienta Tamaio de Lienzo

[ Image Size

Cambie el tamafio de la imagen, cambie el DPI,
width 1600

Height 1000
[ Lock Ratio

extienda o recorte el lienzo.

Para cambiar el tamaiio de la imagen, establezca el
ancho, alto y DPI de |la nueva imagen escribiendo los
Info: valores en los cuadros. Confirme presionando el

1600 x 1000 px botdn OK en la parte inferior del lienzo.
56.44 x 35.28 cm - ior el ~ lai
5222 x 13.89 in También puede cambiar el tamafio de la imagen de

forma interactiva haciendo clic en uno de los puntos

de control y arrastrando la imagen al tamafio
deseado.

Active ‘Mantener Aspecto Original’ o use atajo ‘Shift’
para escalar la imagen proporcionalmente.

Para extender o recortar el lienzo, deseleccione ‘Tamafio de Imagen’, después haga clicy

arrastra uno de los puntos de control. Confirme presionando el botén OK en la parte inferior
del lienzo.
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Brushes

Serene Calligraphy

Colorib Star Chasers Glowy Spiral  Disco Hall

NG,

e
Winter Glam Flowing Flowing 2

(7~

Moderna Gleam Celestial Eternal

Panel de Pinceles

El panel de Pinceles contiene todos los ajustes
preestablecidos para el sistema de particulas
seleccionado. Aqui puede compartir, agregar o
eliminar pinceles o visitar la biblioteca de
pinceles en linea, donde cientos de pinceles
gratis creados por los usuarios estan disponibles
para descargar.

Seleccione el tipo de pinceles que desea ver en
el panel Pinceles:

Todos - El panel mostrara todos los pinceles
para el sistema de particulas seleccionado.
Dibujo - Los pinceles estandar de dibujo y
pintura perfectos para los fundamentos de su
pintura.

Grafico - Pinceles para efectos interesantes para
poster, fondos o para agregar patrones
originales a sus disefios graficos.

Efecto - Pinceles para efectos variados, que van
desde fuego, humo, bokeh hasta lluvia, nubes y
otros patrones de fotos o cualquier fotografia
importada.

Usar Paleta y Fusidén de Pincel - Use la paleta y el modo de fusion individual del pincel
seleccionado. Desactivela si desea utilizar el color actual, el gradiente o la imagen seleccionada

en el panel Paleta y el modo de fusién actualmente seleccionado en el panel Propiedades para

cada pincel.

Iconos Pequefios ¥ | Grandes
pinceles.

- Cambie entre una vista previa pequefia y grande de los

La vista previa grande incluye los nombres de los pinceles.
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Como agregar pinceles

Puede agregar un nuevo pincel de varias maneras: cree un pincel personalizado con el Creador
de Pinceles o descargue el pincel de la biblioteca de pinceles en linea.

Guardar un pincel personalizado

Si desea guardar un pincel personalizado creado en Creador de Pinceles, haga clic en el botén

en la parte inferior del panel Pinceles para agregar un nuevo pincel a la lista de ajustes
preestablecidos.

Al agregar un nuevo pincel, pinte la vista previa del pincel en el cuadro, ingrese el nombre del
pincel, seleccione el tipo de pincel y agregue etiquetas. Haga clic en Del para borrar la vista
previa del pincel.

Para guardar el pincel, haga clic en el botén Guardar o en Enter.

Para regresar sin guardar el pincel, haga clic en Cancelar o en Esc.

Después de guardar, un nuevo pincel aparecera en el panel Pinceles para el sistema de
particulas seleccionado.

NOTA: Al guardar el pincel en el modo "Oscurecer”, sélo el fondo blanco esta disponible. Al
guardar el pincel en el modo "Aclarar", sélo el fondo negro estd disponible.

Para eliminar un pincel de la lista de ajustes preestablecidos, seleccione el pincel que desea

eliminar y haga clic en el botén B en la parte inferior del panel Pinceles.
Descargar pincel de la biblioteca de pinceles en linea

Hay cientos de pinceles gratis para usar cargados por desarrolladores y usuarios en el sitio web
de Escape Motions. Haga clic en el botén en la parte inferior del panel Pinceles para abrir la
biblioteca de pinceles en linea o visite:
www.escapemotions.com/products/flamepainter/brushes

Haga clic en cualquier pincel y simplemente arrastrelo y suéltelo directamente en el Panel
Pinceles de Flame Painter.

Si arrastrar y soltar no funciona desde su navegador, pruebe con otro navegador o descargue el
pincel primero, luego arrastrelo y suéltelo en el panel Pinceles desde su computadora.

Si esto tampoco funciona, copie el pincel descargado y péguelo en la carpeta Pinceles; para
encontrarlo, vaya al menu Flame Painter: Ayuda > Mostrar carpeta de biblioteca. Todos los
pinceles en la carpeta Pinceles aparecerdn en el panel Pinceles después de volver a abrir el
software.
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Como compartir pinceles

Puede compartir sus pinceles favoritos con otros usuarios facilmente. Haga clic en el botén B
en la parte inferior del panel Pinceles para compartir el pincel seleccionado en la biblioteca de
pinceles en linea. Confirme haciendo clic en el botén Compartir. El pincel se cargara
automaticamente en la biblioteca para otros usuarios.

SUGERENCIA: Puede cambiar el orden de los pinceles mediante arrastrar y soltar o cambiar el
nombre del pincel seleccionado haciendo doble clic en él, escribiendo un nuevo nombre y

pulsando Enter.

= Menu de Panel de Pinceles - Cierre el panel. Es posible mostrar el panel de nuevo desde el
Menu de Ventana (Window menu).
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Panel de Navegador

Utilice el panel de Navegador para cambiar con
rapidez la vista de la pintura utilizando una
visualizacién en miniatura. El cuadro negro (blanco)
del navegador corresponde al area visible
actualmente en la ventana.

Q Reducir - Reduzca la vista de la pintura (a un
tamafio minimo de 1%).

Q Aumentar - Aumente la vista de la pintura (a un
213% QO tamafio maximo de 2000%).

100 G M4 Control de Zoom - Ajuste el zoom utilizando el
control de zoom (1 - 2000%).

Q Restablecer Zoom - Compruebe el valor de zoom aqui. Pulse el botdn para restablecer el
zoom al 100%.

(- Encajar en Pantalla - Encaje el lienzo en la pantalla.

SUGERENCIA: También puede aumentar y reducir el lienzo manteniendo presionada la tecla "Z"
en el teclado y haciendo clic con el botdn izquierdo del raton (o toque con el ldpiz) y
arrastrando. Mueva con el ratdn o el Idpiz hacia la derecha o hacia arriba para aumentary
hacia la izquierda o hacia abajo para reducir.

o) Rotar Sinistrorso - Rote la ventana grafica sinistrorso.

@ Rotar Dextrorso - Rote la ventana grafica dextrorso.
Control de Rotacion - Ajuste el valor de rotacién con el control de rotacién (-180° - 180°).

SUGERENCIA: Puede rotar la ventana grdfica presionando el atajo de teclado "R" + botdn
izquierdo del raton y arrastre.

™ Restablecer Rotacion - Pulse el botén para restablecer el valor de rotacién al 0°.
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Pl voltear - Voltee la ventana grafica. Herramienta Voltear en el panel de Navegator voltea la
ventana grafica de forma no destructiva y no transforme el imagen. El botdn esta activado
cuando la ventana grafica esta volteada.

= Menu de Panel de Navegador - Cierre el panel. Es posible mostrar el panel de nuevo desde
el Menu de Ventana (Window Menu).
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Panel de Capas

T Use el panel de Capas para editar y manipular con

Blending Normal capas.
Opacity
Lock 6 = Fusion - 23 modos de fusién: Normal, Oscurecer,

Multiplicar, Subexponer Color, Subexposicién Lineal,
Layer 2 copy L
Aclarar, Trama, Sobreexponer Color, Sobreexposiciéon
Layer 2 Lineal, Superponer, Luz Suave, Luz Fuerte, Luz Intensa,
Layer 1 Luz Lineal, Luz Focal, Mezcla Definida, Diferencia,

Exclusion, Restar, Tono, Saturacién, Reguladores y

Background

Luminosidad.
Opacidad - Ajuste la opacidad de la capa. (0-100).

a Bloquear Capa - Bloquee la capa o capas
seleccionadas para protegerlos de cambios no
deseados.

3 B ':' Bloquear Transparencia - Bloquee pixeles
transparentes en la capa seleccionada. Cuando se

pinta un trazo en una capa y se bloquean pixeles transparentes en esta capa, cada accion se
aplicara sélo en este trazo, no en los pixeles transparentes detras de él.

© Mostrar Seleccidon - Muestre un area seleccionada actual en el lienzo donde se realizaran
otras operaciones. El area inactiva fuera de la seleccién esta coloreada.

® Ojo - Muestra u oculta la capa.

SUGERENCIA: Haga clic en el ojo @ 4l lado de Capa de Fondo para mostrar u ocultar el fondo.
Cuando se oculta, se puede guardar la pintura con el fondo transparente.

@ Limpiar Capa - Limpie el contenido de la capa (atajo Del).

E] Exportar a "PS" - Exporte la capa seleccionada a Photoshop (atajo Ctrl+F / Cmd+F).
Puede encontrar mds informaciones sobre esta opcion en la seccién Flame Painter Connect -

Photoshop Plug-in.

Nueva Capa - Agrega una nueva capa.
New Vector Layer - Add a new vector layer.
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@ Duplicar Capa - Duplique capa o capas activas.

Fusionar Capas - Fusione mas capas en una capa (atajo Ctrl+E / Cmd+E). Si una sola capa
estd seleccionada, se fusionard automaticamente con la capa debajo de ella. Las capas
vectoriales se rasterizaran después de la fusion.

B Eliminar Capa - Elimine la capa o mds capas seleccionadas.

SUGERENCIA: Arrastre la capa seleccionada arriba de cualquiera de estos botones para ejecutar
sus funciones en esa capa.

Se puede cambiar el nombre de una capa activa con un doble clic sobre ella en una Lista de
Capas.

Se puede arrastrar y soltar las capas para acomodarlos en el orden deseado.

Se puede convertir la capa vectorial a mapa de bits a través el menu: Capa > Rasterizar Capa.

= Men de Panel de Capas - Cierre el panel. Es posible mostrar el panel de nuevo desde el
Menu de Ventana (Window Menu).
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Panel de Paleta

Elija si desea pintar con un color, gradiente o con colores de una imagen.

Color

Palette Color Actual - Establezca el color actual. Un solo clic
en el cuadro de color abre una paleta de colores del

I Color * Illl Gradient

sistema.

Color Secundario - Establezca el color secundario.
Puede cambiar entre el color actual y el secundario
haciendo clic en el color secundario.

Paleta de Color - Seleccione el color de la paleta de
colores o ingrese parametros numéricos exactos para
establecer el color requerido.

L Blanco & Negro - Cambie entre el color blanco y negro
&) H354 5189 V255 facilmente directamente desde el panel.

Puede cambiar entre HSV, HSL, HSLuv y RGB modelos de color:
H - Matiz del Pincel (0-359)

S - Saturacién del Pincel (0- 55)

L /V- Luminancia/Valor del Pincel (0-255)

o)

R - Red / Rojo (0-255)

G - Green / Verde (0-255)

B - Blue / Azul (0-255)

NOTA: RGB es un modelo de color dependiente del dispositivo - diferentes dispositivos /
monitores pueden reproducir un valor RGB determinado de manera diferente.

HSLuv - HSLuv le permite definir un color basado en tres dimensiones: tono, saturaciony
luminancia, pero al contrario que un modelo de color HSL basado en RGB, este modelo de color
se basa en el espacio de color CIELUV. Dos colores con un valor de luminosidad idéntico se
veran igual de brillantes, tendran mejor saturacion y uniformidad de tono.
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Q Abrir Biblioteca de Colores - Abra la biblioteca de los colores guardados:

Color Library

“ Ordenar por Matiz - Ordene colores por su valor de Matiz.
Cuando desactivado, el color ultimo anadido se ordenara como
primero.

/B- Agrega y elimina colores personalizados.

** Paleta - Abra la paleta de colores del sistema (System Color
Palette).

Después de hacer clic en un color actual en la esquina superior izquierda del Panel de Paleta o

.
al botdén ¢ ¢ en la Lista de Colores, una nueva ventana de Seleccionar color con una Paleta de
Colores del Sistema aparece. Esta paleta se ve y se comporta de manera diferente en Mac OS y
Windows:

| @006 Colors =)

Dl aeE =
aQ

Pick Screen Color

Custom colors

Add to Custom Colors

Cancel =

. . [
Paleta de Colores de Sistema en Windows = L L

(Cancel) ( OK )

Paleta de Colores de Sistema en

Mac 0S
Para usuarios de Windows:

Puede escoger cualquier color de la pantalla haciendo clic en un botén de "Pick Screen Color".
Al pasar por encima de su pantalla veras HSV, RGB y HTML parametros de un color.
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El uso de la opcion 'Custom Colors' en la ventana de Paleta de colores para guardar los colores

no es necesario. Si desea guardar su color personalisado, le recomendamos que utilice el botén

"Agregar" directamente en la lista de Colores.

NOTA: Es posible que el color que usa para pintar en el modo Aclarar u Oscurecer no sea

exactamente el mismo que ve en el "color del pincel". Esto es tipico de la aplicacidon y los modos

de fusion Aclarar / Oscurecer. Si desea tener el color exacto, elija el modo Normal.

Paletkte

Il Color [l Gradient

G H 147 S 255 v 99

0+ac OO
12

Repeat HlIF =

Stroke Lines Dots

Gradiente

Elija desde gradientes predeterminados o cree su
transicién de gradiente personalizada.

“I" Voltear - Voltee Ia transicion del gradiente.
(¥ Jnvertir - Invierta la transicién del gradiente.

nd) Mover - Mueve colores en el gradiente.
H | S | L- Cambie el matiz, la saturaciény la
luminosidad para todos los colores ene gradiente.

Repetir - Seleccione si el gradiente debe repetirse a
longitud o anchura del trazo: I = y establezca
cuantas veces deberia repetirse. El nUmero mas alto,

los colores cambian con mas frecuencia.

Seleccione si el gradiente debe aplicarse en el trazo, lineas o puntos.
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D Abrir Biblioteca de Colores - Abra la biblioteca con |a paleta de colores y los colores
guardados para cambiar los colores en el gradiente. Haga clic en el botdn de color que desea
cambiar y seleccione el color de la lista de colores. Puede activar / desactivar el color que desea
usar en el gradiente. También puede cambiar el color seleccionado en el gradiente ajustando

sus valores HSV.

Color Library En la Biblioteca de Colores se puede:

Seleccionar su color el la paleta de los colores

/ B - Agregar o eliminar colores a / desde la biblioteca de
colores.

*’ Paleta - Abrir la paleta de colores del sistema (System Color
Palette).

D Abrir Biblioteca de Gradientes - Abra la biblioteca de los gradientes guardados. Aqui se
puede:

Seleccionar los gradientes guardados o

/ B - Agregar o eliminar gradientes a / desde la biblioteca de
gradienes.

Gradient Library
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Imagen

Use cualquier imagen como textura en el trazo.

D Abrir Biblioteca de Imagenes - Abra la biblioteca
con imagenes guardados.

8 7% Establecer Imagen desde Capa/Seleccién -
oo e Establezca la imagen para usar como una paleta

(+) A desde la capa o seleccion.

Il Color [l Gradient mage

EI Importar Imagen - Importe una imagen para usar
Repeat Il 1 P g P genp

como una paleta.
Stroke

@ Rotar Dextrorso - Rote la imagen dextrorso.

A Voltear Horizontalmente - Voltee la imagen
horizontalmente.

I Repetir: Longitud - Repita la imagen en la longitud del trazo. Establezca cuantas veces
deberia repetirse.

= Repetir: Anchura - Repita la imagen en la anchura del trazo. Establezca cuantas veces
deberia repetirse.

Seleccione si la imagen debe aplicarse en el trazo, lineas o puntos.

D Abrir Biblioteca de Imagenes - Abra la biblioteca con imagenes guardados. Aqui se puede:
Image Library Iconos Pequefios | Grandes 5 _ Cambie entre una vista

previa mas pequefia y mas grande de los imagenes.

La vista previa grande incluye nombres de imagenes.

m Importar Textura - Importe una textura en formato de

archivo .png, .jpg, .tif o .bmp.

B Eliminar Textura - Elimine la textura de la Biblioteca de

imagenes.

pattern 10 Texture
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= Men de Panel de Paleta - Cambie entre la paleta circular (color wheel) y paleta cuadrada,
cambie entre HSV, HSL, HSLuv y RGB paleta de color or cierre el panel. Es posible mostrar el
panel de nuevo desde el Menu de Ventana (Window Menu).

También puede seleccionar lo siguiente:

- Establecer Gradiente de Archivo de Imagen... - Elija una imagen para crear una transicién del
gradiente. El gradiente de 9 colores se crea a partir del color mas recurrente en esta imagen.

- Establecer Gradiente de Capa/Seleccidn - Elija una capa o seleccién para crear una transicion
del gradiente. El gradiente de 9 colores se crea a partir del color mas recurrente en esta capa /
seleccion.
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Panel de Creador de Pinceles

Ud. puede crear sus pinceles preestablecidos personalizados en el panel Creador de Pinceles.

Abra el panel con el botdon == en panel de Propiedades o mediante el menu Ventana.

El panel consiste de dos partes:
1. Sistema de particulas - ajustes para el comportamiento del pincel; y
2. Forma - ajustes visuales con respecto a la forma y opacidad del pincel.

Sistema de particulas

Flame Painter 4 presenta seis sistemas de particulas Flame, Ribbon, Follow, Liner, Fuzzy y
Elastic.

El paquete de instalacion incluye tres sistemas de particulas: Flame, Ribbon y Follow, y tres
estan disponibles para descargar: Liner, Fuzzy y Elastic. Todavia forman parte del modo
especial Flame Painter: puede probar todos sus controles y opciones visuales en una "capa de
vista previa".

Flame - El sistema de particulas clasico.

Ribbon - El sistema de particulas de ribbon.

Follow - El trazo sigue al cursor con mayor precision.

Liner - Sistema de particulas de pincel basado en lineas.

Elastic - Sistema de particulas versatil con cursor de pincel elastico.
Fuzzy - Sistema de particulas basado en cuerdas.

Cada sistema de particulas tiene diferentes controles deslizantes que puede usar para editar su
pincel. Se puede encontrar mas informacidn sobre ellos en la seccidn Sistemas de Particulas.

Forma

Fusidn - Modo de fusién de color. Hay tres modos:

- Normal para pintura regular,

- Aclarar es generalmente para los efectos de luz y los fondos oscuros y
- Oscurecer para los fondos mas claros.

Opacidad - Opacidad del pincel (1-100).

@)’ Presion de Stylus - Active la presion de stylus para opacidad.
Cuando esta activo, la opacidad de la pintura varia en una pincelada, hasta (pero no
excediendo) el valor de opacidad especificado en el deslizador Opacidad.
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Seleccione una forma del trazo:

™ Area - Renderizador tipico de Flame Painter 3. Aqui se puede editar los pardmetros del
trazo.

= Linea - Renderizador basado en linea. Aqui se puede editar los parametros del trazo y la
secuencia.

I Linea Punteada - Renderizador de linea basado en puntos. Aqui se puede editar los
parametros del trazo, la secuencia y los puntos.

Forma: Trazo

Opacidad de Trazo - Establezca la opacidad del trazo.
Blending |Lighten Puede elegir una textura que se aplicara al trazo

Opacity

activando la opcion Usar Imagen:

D Abrir Biblioteca de Imagenes - Abra la biblioteca
con imagenes guardadas.

M Fill

= Stroke

- Stroke Opacity .
B Use Image 7! Establecer Imagen desde Capa/Seleccién -

Establezca la imagen para la estructura del trazo
desde la capa o seleccion.

El Importar Imagen - Importe un imagen para usar

Repeat Il 1

como la textura en el trazo.
< Stroke

Detail

l:l Invertir - Invierte la textura actual.

Mouse Pressure

@ Rotar Dextrorso - Rote la imagen a la derecha.

A\ Voltear Horizontalmente - Voltee la textura
actual horizontalmente.

Repetir:
I Repetir: Longitud - Repite la textura a la longitud del trazo.

= Repetir: Anchura - Repite la textura a la anchura del trazo.

Trazo - Establezca el Detalle y valor para opcién Difuminar:
Detalle - Elija el detalle (1-4). Cuanto mas alto es el detalle, mas detallado es el trazo.

-
-

Alternar entre trazo antialiased y aliased con botones: /7
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Presion de Ratodn - Establezca valor de difuminar para el trazo pintado con el ratén (O-
10). Cuanto mayor sea el valor, mayor sera el effecto de difuminar al principio y al final

del trazo.

Blending |Lighten
Opacity

Wy Fill = Line i Dotted Line

= Stroke = Seguence

- Sequence Opacity

M Use Image [ Influenced by Speed
De'e Lt
. @ @
G @ . A

Repeat Il 1 1

- Sequence
Direction Stroke Direction
Profile

Lines Count

Width
Width Jitter

Length
Length Jitter

Pause

Pause Jitter
Random Span

Variable Lines

[] variable Lines Waving

Forma: Secuencia

Opacidad de Secuencia - Establezca la opacidad de
una secuencia. Se puede elegir una textura que se
aplicard a las secuencias activando opcién Usar
Imagen.

Influenciado por Velocidad - Seleccione si la
velocidad con la que pinta influird en la opacidad del
trazo.

Cuando se selecciona, el valor de opacidad sera
mayor en las secuencias pintadas mas lentamente y
menor en las secuencias pintadas mas rapido.

Secuencia - Establezca varios ajustes para la
secuencia:

Direccion - Seleccione entre Direccion de trazo (la
forma se aplicard horizontalmente) y Perfil de forma
(la forma se aplicara verticalmente).

Perfil - Seleccione el perfil de la secuencia.

Numero de Lineas - Establezca el nimero de lineas en
la secuencia (1-100).

Anchura - Establezca anchura de lineas en la secuencia (1-100).

@" Presion de Stylus - Habilite la presion del stylus para anchura.

Cuando esta activo, anchura de las lineas varia en un trazo de pincel, hasta (pero sin exceder) el

valor especificado en el control deslizante Anchura (1-100). La presion del stylus puede ser

positiva o negativa.

Presion de Stylus aplicado a la Anchura de las lineas en una secuencia.
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Variacion de Anchura - Establezca la variacién de anchura de las lineas (0-100). Cuanto mayor
sea el valor, mayor serd la variacion de la anchura entre lineas individuales en el trazo.

Utilizar por Secuencia | Utilizar por Trazo - Seleccione si desea aplicar la variacion de anchura
por una secuencia o por el trazo completo:

W e e [ ———— 4 1 1 1 1 |
o e — I S S S S —
Variacion de Anchura: Utilizar por Secuencia (izquierda) vs. Utilizar por Trazo (derecha)

Longitud - Establezca la longitud de las secuencias en el trazo (1-100).

Longitud de Secuencia Fija - La longitud de la secuencia no cambiara al pintar.

Variacién de Longitud - Establezca la variacién de longitud de las lineas (0-100). Cuanto mayor
sea el valor, mayor serd la variacién de longitud entre secuencias individuales en el trazo.

Ejemplos de Longitud y Variacién de Longitud:

N NN BN NN BN AN NN AN S . . ST B B I LD L
I N AN RN AN N N N . . .- " s W 1 Y EEEEE D EEE W e
WS SN SN NN BN SN SN N AN . . W7 ] N WSE WmAES W W = W
SN SN TN NN TN SN N N WS . - SN f N F W OW R EEE e

Longitud = 10. No variacion.  Longitud = 40. No variacion.  Variacion de Longitud a 40.

Pausa - Establezca la longitud de pausa entre secuencias individuales en el trazo (0-100).
Variacion de Pausa - Establezca la variacidon de pausa entre secuencias individuales (0-100).
Cuanto mayor sea el valor, mayor sera la diferencia en la longitud de las pausas entre
secuencias individuales:

Variacion de Pausa = 0. Variacion de Pausa = 25.

Lapso Aleatorio - Establezca el lapso aleatorio entre las secuencias en el trazo (0-100). Cuanto
mayor sea el valor, mayor serd el lapso entre las lineas:

Varios niveles de Lapso Aleatorio en el trazo con 4 lineas.



Lineas Variables - La influencia de la presién del stylus es variable para cada linea (0-100).
Cuanto mayor sea el valor, mds aleatoriamente cada linea comienza y termina basado en Ia
presion.

Ondulacion de Lineas Variables - La presion del stylus varia durante el trazo.

Forma: Linea Punteada

Opacidad de Puntos - Establezca la opacidad de los

Blending [Lighten puntos. Se puede elegir una textura que se aplicara a

Opacity . .
pach los puntos activando opcién Usar Imagen.

Ry Fill i Aqui puede agregar varias texturas de imagen, hasta

cuatro:
Dot Opacity

+ Agregar Imagen.

M Use Image

4 Imagen Anterior.
» Imagen Siguiente.

X Eliminar Imagen.
173 + 4 » X

. L —h ..
Cambie entre orden secuencial = o aleatorio f'.
- Dots

Orden aleatorio elige la textura de imagen

Size
size Jicter aleatoriamente.

Opacty e >0 Tamafio - Establezca el tamafio de los puntos en el
is:z::zmter trazo (1-100).

e & presién de Stylus - Habilite la presion del stylus

Angle Jitter

[ Follow Trajectory para el tamafio.

Cuando esta activo, el tamafio de los puntos varia en
un trazo de pincel, hasta (pero sin exceder) el valor
especificado en el control deslizante Tamafio (1-100).

La presidén del stylus puede ser positiva o negativa.

Variacion de Tamano - Establezca la variacién del tamafio de los puntos (0-100). Cuanto mayor
sea el valor, mayores seran las variaciones entre el tamafio de los puntos individuales:

(A EEEEXE EN FEN N NN NNEXN EYN N NEFY X

DO G 009 020 0 *0::902:0:00:0:00000°2-000°0O

Variacion de Tamafio aplicado a los puntos.
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Variacién de Opacidad - Establezca la variacién de opacidad de los puntos. Cuanto mayor sea
el valor, mayores seran las variaciones en la opacidad de los puntos individuales.
o o000 000000 00 o 000 00
00 90 o ® o ® 00 0000

0000 "00 00 e00000 00O o0 00 ©
@ o0 o 0o 0000 00 o 0000

Variacidon de Opacidad aplicado a los puntos.

Espaciado - Establezca el espaciado entre los puntos (1-999). Cuanto mayor sea el valor,
mayores seran las variaciones en el espacio entre puntos.
Variacion de Espaciado - Aleatoriza el espacio entre los puntos (0-100):

® O O 000 00 00 0 0 ® © o000 00

000 O 0 ® 00 00 © 000 ® o

»P © 00 00 ™o O o000 @ 00 o ¢

00 000 00 0 O 000 00 0 0 © 0 00
Variacion de Espaciado = 50.

Dispersion - La dispersion del pincel aleatoriza la colocacion de los puntos en un trazo hacia
arriba o hacia abajo con respecto a la linea de base de la pincelada (1-100).

0000 cececooe 000 g9%000%000 .. e%e0e0_, "'.
LR BN IR I ) ©®0000%0000 odee 0:.:'.'
0000000000000 g000%0e0%000% 000" '0'000‘..0.0..
©00000000000e 0,000,0%°0%°00° 00°4,,"%¢,° oo
Dispersion =0 Dispersion = 25 Dispersion = 50

Variacion de Angulo - Establezca la variacion de angulo de los puntos (0-100). Cuanto mayor
sea el valor, mayor serd la diferencia entre el angulo de los puntos individuales:

\" ;'a ": \'a \" \" "; \'a \" \" \" "‘ :p :; qg 9 %' 4§ ", qg ." ¢§
BRI JRRR, R R R RN PR B o s b o :0 ”w ’pqg M ,“ "‘ " qe
R JUNC JRIC R, JRR RIS R, RO NP R, "~ ﬁ LA :‘ » "0 ~ & a "
R RN R JR JRR. JR RIS PRI . % 4 3 - LA I L g M T “ .

Variacién de Angulo = 0. Variacién de Angulo = 50.

Seguir Trayectoria - El pincel sigue la rotacién de la trayectoria del trazo.

= Men de Panel de Creador de Pinceles - Guarde su pincel personalisado como un pincel
preestablecido nuevo, Restablezca cambios de pincel, Actualice particulas solo en movimiento
o Cierre the panel. Es posible mostrar el panel de nuevo desde el Menu de Ventana (Window
Menu).
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Sistemas de Particulas

El sistema de particulas es la fundacién de Flame Painter, un tipo de simulacidon que define la
apariencia del trazo del pincel, su comportamiento, la forma en que se mueve el pincel y
muchos otros parametros importantes.

Flame Painter 4 presenta seis sistemas de particulas Flame, Ribbon, Follow, Liner, Fuzzy y
Elastic. El paquete de instalacion incluye tres sistemas de particulas: Flame, Ribbon y Follow, y
tres estan disponibles para descargar: Liner, Fuzzy y Elastic. Todavia forman parte del modo
especial Flame Painter: puede probar todos sus controles y opciones visuales en una "capa de
vista previa".

NOTA: La cantidad mdxima permitida de dispositivos en los que se pueden activar los sistemas

de particulas es de tres (3). Si supera este numero, Flame Painter le pedird que cierre sesion en
uno o todos sus dispositivos a través de su cuenta de la Comunidad.

Sistema de Particulas Flame

Este es el sistema clasico de particulas de flame
para crear diversos efectos desde filetes de

» Getmore...

fuego hasta arreglos aleatorios de particulas,

- humo, efectos de luz, destellos y mucho mas.
1ze

Particles
Span : En la sistema de particulas Flame puede influir

Soft : en estos pardmetros:
Speed
HETIEEE Tamafio - Establezca el tamafio del pincel (1-
- 0.

Particulas - Establezca el nUmero de particulas
en el pincel (1-300).
Lapso - Establezca el lapso entre los particulas
en el pincel (0-10).

Noise

Blandura - Establezca la blandura del pincel (1-
100). Los valores mas altos de este parametro ralentizan la velocidad del trazo y crean un trazo
mas definido.
Velocidad - Establezca la velocidad de particulas que representan el tiempo de reaccidn del
pincel (1-100). Cuanto mayor sea la velocidad, mas activo pincel obtendra.
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Centro - Establezca la fuerza de atraccién global de las particulas. (0-100). Los valores mas altos
se establecen, la mayor fuerza de atraccidn de las particulas es hacia el cursor. Con el ajuste de
centro alto, las particulas estdn mas centradas cerca del cursor del pincel.

Foco - Establezca la fuerza de atraccion individual de las particulas (0-100). Cada particula tiene
una fuerza de atraccion diferente al cursor del pincel. Cuanto mayores son los valores, mayor
es la diferencia de fuerza entre la primeray la Ultima particula.

Caos - Establezca el parametro de caos del pincel (0-100). Cuanto mds cerca estan las particulas
al lado del cursor, mas cadticas se vuelven.

Ruido - Establezca el parametro de ruido del pincel (0-100). Cada particula tiene una fuerza de
atraccion aleatoria pero constante. Cuanto mayor sea el nimero, mas ruidoso se vuelve el
pincel.

Sistema de Particulas Ribbon

El elegante sistema de particulas para crear

hermosos efectos de disefio. El trazo de la
Ribbon » Get more...

ribbon se extiende un poco mas, creando trazos

fluidos perfectos para disefar ondas abstractas,
Size

, sedas, telas, efectos similares a una cinta que
Particles

fluyen con la direccién de su trazo.

Length

Speed
Focus

Flexibility

En la sistema de particulas Ribbon puede influir en estos parametros:

Tamaino - Establezca el tamafio del pincel (1-100).

Particulas - Establezca el numero de particulas en el pincel (1-100).

Longitud - Establezca la longitud del trazo (1-100).

Blandura - Establezca la blandura del pincel (1-100). Los valores mas altos de este parametro
ralentizan la velocidad del trazo y crean un trazo mas definido.

Velocidad - Establezca la velocidad de particulas que representan el tiempo de reaccion del
pincel (1-100). Cuanto mayor sea la velocidad, mas activo pincel obtendra.

Foco - Establezca la fuerza de atraccidn individual de las particulas (0-100). Cada particula tiene
una fuerza de atraccion diferente al cursor del pincel. Cuanto mayores son los valores, mayor
es la diferencia de fuerza entre la primeray la ultima particula.
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Flexibilidad - Establezca la flexibilidad de la longitud del picel ribbon (1-100). Cuando se
establece al maximo, incluso con alta velocidad, la longitud del pincel se extiende hasta la
longitud deseada.

Sistema de Particulas Follow

En el sistema de particulas Follow, el trazo sigue

el cursor con mayor precisién y es adecuado

Follow Get more...

para trazos de pintura mas detallados, asi como

. lineas de destellos abstractos, érbitas o pinceles
1ze

: con textura.

Particles

Radius

En la sistema de particulas Follow puede influir

Speed
Center i en estos parémetros:

Focus

Chaos Tamano - Establezca el tamano del pincel (1-

100).

Noise

Particulas - Establezca el nimero de particulas en el pincel (1-100).

Radio - Establezca el radio de los particulas en el pincel (0-100).

Velocidad - Establezca la velocidad de particulas que representan el tiempo de reaccidon del
pincel (1-100). Cuanto mayor sea la velocidad, mas activo pincel obtendra.

Centro - Establezca la fuerza de atraccién global de las particulas. (0-100). Los valores mas altos
se establecen, la mayor fuerza de atraccidn de las particulas es hacia el cursor. Con el ajuste de
centro alto, las particulas estdn mas centradas cerca del cursor del pincel.

Foco - Establezca la fuerza de atraccién individual de las particulas (0-100). Cada particula tiene
una fuerza de atraccion diferente al cursor del pincel. Cuanto mayores son los valores, mayor
es la diferencia de fuerza entre la primera y la ultima particula.

Caos - Establezca el parametro de caos del pincel (0-100). Cuanto mas cerca estan las particulas
al lado del cursor, mas cadticas se vuelven.

Ruido - Establezca el parametro de ruido del pincel (0-100). Cada particula tiene una fuerza de
atraccion aleatoria pero constante. Cuanto mayor sea el nimero, mas ruidoso se vuelve el
pincel.
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Sistema de Particulas Liner

El sistema de particulas de Liner tiene un perfil
* Getmore.. del pincel plano y delgado con un ancho
definido. Puede dibujar lineas precisas que

Size : pueden consistir en diferentes formas. Es un
Smooth sistema de particulas de pincel perfecto para

crear lineas, senderos, rayas y superficies
exactas. Puedes crear increibles pinceles, lineas
clasicas o pinceles de diferentes formas.

En la sistema de particulas Liner puede influir en estos pardmetros:

Tamano - Establezca el tamafio del pincel (1-500).

Suavizado - Establezca la velocidad de cdmo las particulas siguen el cursor y el suavizado de
angulo para el trazo curvo (0-10). Cuanto mayor sea el nUmero, mas suaves seran las lineas que
puede dibujar y mas nitido el angulo de la curva.

Sistema de Particulas Elastic

Sistema de particulas versatil con un cursor de
Slaeie Cet more... pincel eldstico perfecto para agregar

profundidad a sus preajustes, creando efectos

e suaves con varios comportamientos eldsticos.

Particles
Radius En la sistema de particulas Elastic puede influir

Elasticity : en estos parametros:

Speed

Noise : Tamaiio - Establezca el tamafio del pincel (1-
Mod: Freg O . 100)_

Particulas - Establezca el numero de particulas
en el pincel (1-100).

Radio - Establezca el radio de los particulas en el pincel (0-100).
Elasticidad - Establezca la elasticidad del pincel (1-100). Cuanto mayor es el nimero, mas
elastica es la forma del pincel.
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Velocidad - Establezca la velocidad del pincel que representa el tiempo de reaccién de forma
elastica (1-100).

Ruido - Establezca el parametro de ruido del pincel (0-100). Cuanto mayor sea el nimero, mas
ruidoso se vuelve el pincel.

Mod - Cambie la forma del pincel eldstico con un modificador de onda sinusal:

Frecuencia - Establezca la frecuencia de la onda.
Radio - Establezca el radio de la onda.

Sistema de Particulas Fuzzy

Un sistema de particulas basado en cadenas que
puede estirar sus particulas a lo largo del camino

Gelt more...

perfecto para crear trazos difusos, tentaculos o

Size grupos de formas abstractas.

Particles

Length . En la sistema de particulas Fuzzy puede influir en
Strings estos parametros:

ETIN

Softness ' Tamaiio - Establezca el tamafio del pincel (1-
Speed / 100)

Speed Noise , , ,
Particulas - Establezca el nimero de particulas

en cada cadena del pincel (1-100).

Longitud - Establezca la longitud del trazo (1-100).
Cadenas - Establezca el numero de cadenas en el pincel (1-30).
Radio - Establezca el radio de los particulas en el pincel (0-100).

Blandura - Establezca la blandura del pincel (1-100). Cuanto mayor sea el nimero, mas suave
serd el trazo.

Velocidad - Establezca la velocidad de particulas que representan el tiempo de reaccidn del
pincel (1-100).

Ruido de Velocidad - Establezca el comportamiento de las cadenas (0-100). Cuanto mayor sea
el nimero, mayor sera la diferencia en el comportamiento de cada cadena.
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Barra de Menu

Archivo - Contiene acciones relacionadas con cargar, guardar y exportar sus pinturas.
Editar - Contiene articulos relacionados con la edicidn del proceso de pintura y el lienzo.
Capa - Contiene acciones relacionadas con las capas.

Filtro - Contiene acciones relacionadas con la correccidn de color y los efectos.

Vista - Contiene acciones relacionadas con la ventana grafica.

Ventana - Contiene acciones relacionadas con la interfaz de usuario.

Comunidad - Contiene enlaces al foro de la comunidad, galeria, su cuenta y opcién para
publicar pinturas.

Ayuda - Contiene acciones que permiten obtener ayuda de la aplicacién o buscar
actualizaciones en la pagina web.

Menu de Archivo

El Menu de Archivo contiene acciones relacionadas con su pintura de la siguiente manera:

Nuevo... - Abre el cuadro de didlogo que le permite crear una nueva pintura con los nuevos
ajustes, abrir una pitnura reciente quardada o abrir imagenes.

Puede establecer la anchuray la altura de la nueva pintura y una DPI; elegir mantener aspecto
original; cambiar entre la orientacion vertical y horizontal y establecer el color del fondo:

Open... Canvas Size: Canvas Size Info:

¢ Width: 1600 pixels DPI: - ISP 1600 x 1000 pixels

Recent: (=] ® 56.44 x 35.28 cm
Y Height: 1000 pixels

Oinch 22.22 x 13.89 inches

Print Screen % Favorites Background Color:

A4 Default, 29.70 x 21.00 cm, 200 DPI Black
A4, 29.70 x 21.00 cm, 300 DPI

A3, 42.00 x 29.70 cm, 200 DPI

B4, 13.90 x 9.80 inches, 300 DPI

B3, 19.70 x 13.90 inches, 200 DPI

Letter, 11.00 x 8.00 inches, 300 DPI

Quarter Sheet 200, 15.00 x 11.00 inches, 300 DPI

Half Sheet, 22.00 x 15.00 inches, 200 DPI

[ Don't Show on Startup
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Puede abrir cualquier imagen en el formato de archivo .fpa, .psd, .png, .jpg, .omp y .tif de su
computadora a través el botén “Abrir...”.

Sus trabajos recientes se enumeran en el lado izquierdo del cuadro de didlogo Nueva Pintura.
Haga clic en el nombre del trabajo para abrirlo. Para borrar la lista de los trabajos recientes,
haga clic en el botdén "Limpiar Lista".

Para crear una nueva pintura, puede establecer sus propias dimensiones en pixeles,
centimetros y pulgadas con DPI. De acuerdo con el DPI que configurd, la informacion del
tamano de la imagen se calculard automaticamente en centimetros y pulgadas.

También puede elegir entre una variedad de ajustes preestablecidos de tamano de lienzo de
Impresidon y Pantalla o agregar / eliminar ajustes preestablecidos usando los botones @/@

Guarde sus preajustes favoritos en 'Favoritos' marcandolos con una estrella *,

ﬁ" Mantener Aspecto Original - Haga clic para bloquear aspecto original. Cuando resaltado, el

L aspecto original estd bloqueado.

I:l - Cambie a orientacion vertical.

O Cambie a orientacion horizontal.

Abrir... - Abre el cuadro de didlogo que le permite cargar una imagen desde disco en el formato
fpa, .psd, .png, .jpg, .bmp v .tif.

Abrir Reciente - Abre una de las uUltimas pinturas guardadas. Puede limpiar la lista usando la
funcién ‘Limpiar lista’“.

Guardar... - Guarde su pintura. Si no ha guardado anteriormente, se le pedira que introduzca el
nombre.

Guardar Como... - Guarde una copia de su pintura actual como una nueva en formatos de .fpa,
.psd, .png, .jpg, .bmp vy .tif.

Guardar lterativo - Guarde versiones numeradas secuencialmente de una imagen. La primera
vez, " 1" se aflade al nombre del archivo. Posteriormente, cada vez el niUmero se incrementa
en 1y se crea un nuevo archivo numerados secuencialmente.

Importar Imagen... - Importe una imagen en formatos .psd, .png, .jpg, .omp vy .tif como la
nueva capa. También se puede importar una capa vectorial en formato .svg.

Importar Pinceles... - Importe pinceles .png creados en Flame Painter. Los pinceles se
importaran a sistemas de particulas particulares.

Exportar capa a SVG... - Exporte la capa vectortorial activa como poligonos a formato de
graficos vectoriales escalables. Puede encontrar mds informacién sobre esta opcién en la
seccion Importar & Exportar Formato Vectorial.
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SUGERENCIA: Flame Painter guarda automdticamente el trabajo mientras pinta. Cuando esto

suceda, verd un icono que aparecerd en la esquina superior izquierda del lienzo y al lado
del cursor de pintura. Puede configurar el temporizador de autoguardar o desactivar la funcion
de autoguardar mediante Preferencias > General > Autoguardar.

Quit - Close the application. (Only on Windows).
SUGERENCIA: También puede arrastrar y soltar (Drag & Drop) una imagen desde cualquier

aplicacion, archivo o navegador de Internet directamente a Flame Painter si la aplicacion lo
permite.

Para obtener mas informacidn sobre como crear, cargar y guardar sus pinturas, consulte la
seccion Crear, Cargar y Guardar Pinturas mds adelante en el manual.

Menu de Editar

Deshacer - Deshace la ultima operacion de pintura que ha realizado. NUmero de pasos para
deshacer depende de la memoria de su ordenador. Numero maximo de estos pasos es 100.
Rehacer - Rehace la ultima operacién de deshacer.

NOTA: Si no puede deshacer, compruebe la configuracion ,Mdx. Memoria‘ usada en
Preferencias > General > Memoria. Establézcalo en valores mds altos para poder usar las
funciones Deshacer / Rehacer.

Cortar - Corte la seleccidon actual o una capa seleccionada al portapapeles.
Copiar - Copie la seleccidn actual o una capa seleccionada al portapapeles.
Pegar - Pegue la seleccidn actual o una capa seleccionada a la capa nueva.

Tamafio de Imagen - Cambie el tamafio del lienzo y del imagen.
Tamaio de Lienzo - Agrande o recorte el lienzo.

Seleccionar Todo - Seleccione la capa completa.
Deseleccionar Todo - Deseleccione la seleccidon actual desde el lienzo.
Invertir Seleccidn - Invierta la seleccion actual.

Herramienta Regla - Active la herramienta regla en el lienzo.
Herramienta Perspectiva - Active la herramienta perspectiva en el lienzo.
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Mas informaciones sobre las herramientas regla y perspectiva se puede obtener en la seccién
Trabajar con Regla y Perspectiva.

Herramienta Editar - Editar vértices claves y modificar el vector creado. Haga clic en vértices
para cambiar a vértices claves.

Herramienta Editar Grupo - Editar grupo de vértices.

Herramienta Agregar y Eliminar - Retire vértices editables desde el trazo (atajo: Ctrl en
Windows / Cmd en Mac OS).

Transformar Curva Inicial - Cambiar el tamaiio, rotar y escalar una curva inicial del trazo.

Preferencias... - Ajuste Preferencias General, Preferencias de Herramientas, de Color, de
Tableta y del Teclado. Puede encontrar mas informacién en la seccion Preferencias mas
adelante en el manual.

Atajos de Teclado - Abre y edita los atajos del teclado.

Menu de Capa

Nueva Capa - Agrega una nueva capa.

Nueva Capa Vectorial - Agrega una nueva capa vectorial.
Duplicar Capa - Duplica capa o capas activas.

Fusionar Capas - Fusione capas en una sola capa.
Eliminar Capa - Elimine capa o capas activas.

Mostrar Capa - Muestre u oculte la capa individual.
Rasterizar Capa - Turn the selected vector layer to bitmap.

Transformar Capa - Mueve y escale la capa activa (atajo Ctrl+T).
Limpiar Capa - Limpia la capa (atajo Del).

Exportar a Photoshop - Exporte la capa con la configuracién de capa, el modo de fusion y la
opacidad de Flame Painter a Photoshop. Puede encontrar mds informaciones sobre esta opcién
en la seccion Flame Painter Connect - Photoshop Plug-in.

Renderizador HiRes... - Establezca el detalle del Renderizador HiRes (1-5). Un Renderizador
HiRes is a polygonal renderer. es un renderizador poligonal. Llena el espacio entre puntosy
suaviza la imagen sin la aparicién de artefactos de muaré. Solo se puede usar con capas
vectoriales y renderizador Area.
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Cuando finaliza la representacion de renderizador HiRes, la imagen renderizada reemplazarid la
capa actual. “HQ" aparece en el panel superior y significa “high quality = alta calidad”. Cuando
se realizan ediciones adicionales en la capa vectorial renerizada, “HQ"” desaparece y la capa
vectorial necesita ser renderizada nuevamente.

Presione la tecla Esc para cancelar el renderizado. Por favor espere hasta que el proceso haya
terminado.

NOTA: El renderizador HiRes es muy intensivo en computo, puede representar una capa
vectorial incluso unas pocas horas. El tiempo de renderizado depende en gran medida de la
longitud del pincel, asi como de la configuracion del parametro "Tamano". Cuanto mds grande
es el trazo de pincel y el tamaino, mds tiempo se tarda en renderizar.

Ejemplo: Si la capa vectorial se compone de 100 000 poligonos y Detalle de HiRes Renderer se
ajuste en 1, se puede renderizar 1 minuto. Si se ajuste en 2, se cuadruplica el nimero de
poligonos, por lo que el numero de poligonos serd de 400 000 y va a renderizar 4 minutos. Si se
ajuste en 3, el numero serd de 1 600 000 y el tiempo serd de 16 minutos. Si se ajuste en 4, el
numero serd de 6 400 000 y el tiempo serd 64 minutos. Si se ajuste a 5, el numero serd de 25
600 000 y el tiempo serd 256 minutos, circa 4 horas.

Menu de Filtro

Brillo/Contraste... - Ajuste el brillo y el contraste de los colores en una capa actual o en una
seleccion.

Matiz/Saturacion... - Ajuste el brillo y el matiz, la saturacion y la luminancia de los colores en
una capa actual o en una seleccion.

Equilibrio de Color... - Ajuste la mezcla global de colores en una capa actual o en una seleccion
para la correccion de color generalizada.

Arrastre un regulador hacia el color que desee aumentar en la imagen; arrastre un regulador
lejos del color que desee disminuir en la imagen. Los valores pueden estar comprendidos entre
-100 y +100.

Seleccione Sombras, Medios tonos o lluminaciones para seleccionar la gama tonal en la que
desea enfocar los cambios.
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Seleccione Conservar luminosidad para impedir que cambien los valores de luminosidad de la
imagen mientras cambia el color. Esta opcidn mantiene el equilibrio tonal de la imagen.

Haga clic en 'Restablecer' para restablecer los valores, 'Aplicar' para aplicar los cambios o
'Cancelar’ si decide no hacerlo.

Filtro de Color... - Aplique el filtro de color en una capa actual o en una seleccion. Elija el color
de la paleta de colores del sistema. Para ajustar la cantidad de color aplicado a la imagen, use
el control deslizante Fuerza - una mayor fuerza da como resultado un ajuste de color mas
intenso.

Seleccione Conservar luminosidad para impedir que cambien los valores de luminosidad de la
imagen mientras cambia el color. Esta opcién mantiene el equilibrio tonal de la imagen.

Colorear... - Colorea la capa con el deslizador de Matiz, Saturacién y Fuerza.

Desaturar - Convierta todos los colores en una capa actual o en una seleccidn a los tonos de
gris correspondientes. Los colores en la capa siguen siendo valores RGB con tres componentes.
Elija tonos de gris en funcion de 'Luminosidad’ o 'Promedio’. Active 'Vista previa' para verificar
los cambios de color en tiempo real.

Invertir - Invierte todos los colores de pixeles y los valores de brillo en una capa actual o en una
seleccién

Blanco a Transparente - Convierta el color blanco de una capa actual en un canal alfa.
Negro a Transparente - Convierta el color negro de una capa actual en un canal alfa.

SUGERENCIA: Importe su imagen con fondo blanco o negro. Aplique el filtro 'Blanco a
Transparente' o Negro a Transparente'. El fondo se volverd transparente mientras el contenido
del imagen permanezca.

Desenfoque... - Establezca el radio de desenfoque de una ventana emergente.
- Vista Previa - Muestre u oculte el resultado en tiempo real.

Brillo - Establezca el radio y |a fuerza del brillo de una ventana emergente.
- Vista Previa - Muestra u oculta el resultado en tiempo real.

Capa de Azulejos - Active esta opcion para colocar la capa en mosaico horizontal y
verticalmente.
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Menu de Vista

Aumentar - Aumente la vista de la pintura (a tamafio maximo de 2000%).

Reducir - Reduzca la vista de la pintura (a un minimo del 1%).

Aumentar al 100% - Comprueba el valor de zoom. Pulse el botdn para restablecer el zoom al
100%.

Encajar en Pantalla - Encaje el lienzo en la pantalla.

Ajustar al Lienzo - Establezca esta opcion para permitir que las transformaciones se ajusten a
los bordes del lienzo.

Mostrar Cursor - Muestre u oculte el cursor.
Mostrar Particulas - Elija la forma en que se mostrardn las particulas:
e Ningunas - Las particulas no se mostraran.
e Puntos - Las particulas se mostraran como puntos.
e Lineas - Las particulas se mostrardan como lineas.
Vista Previa de Particulas - Elija cbmo cambia la vista previa del cursor mientras se ajusta la
configuracion en el panel Creador de Pinceles:
e Estatico - La vista previa del cursor se actualiza durante la pintura.
e Centro - La vista previa del cursor se actualiza automaticamente en el centro del lienzo.
e Lemniscata - La vista previa del cursor se actualiza automaticamente mientras sigue una
trayectoria de curva en forma de <© en el centro del lienzo.

Mostrar Frontera Segura - Muestre u oculte la frontera segura - un lienzo extendido con mas
espacio visible que el tamafio del lienzo.

Permanecer Arriba - Aplicacion permanecera siempre en la parte superior de otras
aplicaciones.

Pantalla Completa - Cambie la ventana de la aplicacién en modo de pantalla completa
(Presione Esc para salir).

Menu de Ventana

Herramientas - Muestre u oculte el Panel de Herramientas.
Propiedades - Muestre u oculte el Panel de Propiedades.
Navegador - Muestre u oculte el Panel de Navegador.
Paleta - Muestre u oculte el Panel de Paleta.

Pinceles - Muestre u oculte el Panel de Pinceles.
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Capas - Muestre u oculte el Panel de Capas.
Creador de Pinceles - Muestre u oculte el Panel de Creador de Pinceles

Mostrar Paneles - Muestre u oculte los Paneles para conseguir mas espacio para la pintura
(atajo: Tab).

Bloquear Paneles - Bloquee la configuracién de los paneles de cualquier cambio no deseado.
Cuando estan blogueados, no es posible desacoplar paneles, acoplar paneles flotantes o
fusionar paneles.

Mostrar Menu Principal - Muestre u oculte el menu principal (atajo: Ctrl+M).

Importar Diseio - Importe el disefio de interfaz de usuario de Flame Painter previamente
guardado.
Exportar Diseiio - Guarde un disefio de interfaz de usuario Flame Painter personalizado.

Restablecer a Predeterminado - Restablezca la interfaz a interfaz predeterminada.

Menu de Comunidad

Foro - Visite el foro de Escape Motions para leer las preguntas frecuentes, encontrar
informacién util, participar en discusiones sobre el software, obtener sugerencias y trucos,
compartir sus comentarios y mas.

Galeria - Navega por la galeria y publica tus pinturas.

Mi cuenta - Visite su cuenta donde puede cargar su pintura a la galeria, editar su perfil y
cambiar la contrasefa, o descargar el software y los recursos comprados.

Publicar... - Publique su pintura en la Galeria de Communidad. Introduzca el nombre de la
pintura, opcionalmente escriba una descripcion y etiquetas.

Menu de Ayuda

Ayuda - Abra este Manual de Usuario.

Enviar Comentarios... - Envienos sus comentarios si usted tiene cualquier problema, una idea o
simplemente le gusta el programa. Puede elegir entre 3 tipos de comentarios:

Bravo - ¢ Le gustaria expresar cémo genial Flame Painter es?

Idea - ¢ Tiene alguna caracteristica que seria una gran adicidén a Flame Painter?
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Bug - ¢Encontrd cualquier comportamiento curioso al utilizar Flame Painter?

...introduzca su correo electrénico y mensaje - leemos cada uno. ©

Feedback type:

# Bravo

Email:

Message:

Pagina web de Flame Painter - Enlace a la pagina web: flame.escapemotions.com
Idioma - Seleccione el idioma de la interfaz de usuario de Flame Painter. Reinicie Flame Painter
para aplicar los cambios.

Acerca de Flame Painter - Obtenga un poco de informacién basica acerca de Flame Painter,
copyright y créditos.

Mostrar Carpeta de Biblioteca... - Muestra carpeta donde se guardan los pinceles, texturas,
gradientes, datos, documentos y licencia.

Biblioteca de Pinceles en linea... - Visite la biblioteca de pinceles Flame Painter creados por
desarrolladores y otros usuarios.

Buscar actualizaciones... - Este botdn es visible cuando hay nuevas actualizaciones disponibles.
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Preferencias

Flame Painter le permite personalizar muchos ajustes y atajos de teclado en la ventana
Preferencias accesible desde el menu Editar. Establezca las Preferencias General, Preferencias
de Herramientas, de la Tableta y del Teclado en Flame Painter.

Preferencias General

Pantalla de Inicio - No mostrar cuadro de dialégo de "Nueva Pintura" al inicializacién de la
aplicacién - Marque esta opcidn si desea que el cuadro de didlogo “Nueva
Pintura” abre cada vez que inicie la aplicacion.

Interfaz - Ajuste la escala para cambiar el tamano de la interfaz (70-200%). La escala
predeterminada es 100%.

Lienzo - Aumentar al cursor - Marque esta opcién si desea aumentar al cursor y no al
centro del lienzo.

Opciones de Jpeg - Establezca la calidad del archivo Jpeg (0-100). Cuanto menor sea el ajuste,
menor sera la calidad del archivo .jpeg guardado.

Sensibilidad de Box de Editar - Ajuste la sensibilidad de editar del spinbox para el Ratén o
Tableta gréfica (1-100) - Establezca un valor mas alto para que los cuadros
(boxes) sean mas sensibles a la resistencia de la pluma/el ratén.

Memoria - Establezca la memoria maxima que Flame Painter puede usar.
- Nunca mostrar aviso aviso de memoria baja - Seleccione esta opcidn si no
desea ver un mensaje de aviso sobre el nimero limitado de pasos para deshacer
debido a la poca memoria.

Idioma - Seleccione el idioma de la interfaz de usuario. Seleccione si los idiomas se deben
actualizar automaticamente o no.

Autoguardar - Habilite la funcién de autoguardar que guardara automaticamente el trabajo
actual desde Flame Painter. Establezca el tiempo (en minutos) que desea que
Flame Painter guarde automaticamente.
Puede encontrar sus trabajos guardados automaticamente en el menu
Ayuda > Mostrar carpeta de biblioteca > Autosave.

Frontera Segura - Activa o desactiva la visibilidad de la frontera. Establezca el tamafio y la
opacidad de la frontera segura en % del tamafio del lienzo actual.

Informacion sobre Herramientas - Anule la seleccién de esta opcidn si no desea que la
informacion sobre herramientas se muestre al pasar el mouse o el stylus sobre
las herramientas.
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Preferencias de Herramientas

Transformacidn - Establezca el dngulo de bloqueo personalizado para transformar cuando se
usa Shift con rotacion.

Lazy Mouse -Suavizado de la Posicion del Cursor - Ajuste la fuerza del Lazy Mouse (0-10). El
mayor es numero de control de Lazy Mouse, las lineas mds suaves se pueden pintar.

Presion de Raton - Siempre utilice una presion minima del ratéon para el desvanecimiento del
trazo -Anule la seleccién de esta opcidn si no desea utilizar un efecto de presion artificial al usar
un ratén. Esto funciona cuando el valor de opcién Difuminar para el pincel seleccionado se
establece en 0 y hay sensibilidad a la presidn en el parametro del pincel.

Preferencias de Tableta

Opciones de Tableta - Seleccione Usar el posicion del ratéon o stylus y dispositivo Wacom
(WinTab) o Microsoft Ink.

- Invertir inclinacion de stylus - Seleccione esta opcion en caso de que la
inclinacién de su stylus vaya en la direccion opuesta.

- Habilitar toque - Active / desactive el soporte para los gestos de toque en
Flame Painter. Es posible activar solo el toque con un dedo o activar soporte
multitactil.

- Utilizar para rotacion del lienzo - Anule la seleccidn de esta opcidn si no desea
rotar el lienzo con dos dedos. El toque con dos dedos seguira funcionando para
escalar y moverse.

- Sensibilidad de Touchpad - Ajuste la sensibilidad para touchpads y trackpads (1-
100%) - cuando se establece en valores mas altos, la sensibilidad de la accién de
'mover' con el toque en trackpads sera mas significativa.

Suavizado de Presidn de Stylus - Establezca el suavizado de la presion para el stylus. Cuando se
establece en el valor "Max", las transiciones de presion en el trazo seran mas
suaves.

Sensibilidad de Presion de Stylus - Establezca el suavizado de la curva de sensibilidad a la
presidn para el stylus. Cuando se establece en "Suave", se requiere menos
presidn, cuando se establece en "Firme" se requiere mds presion.
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Preferencias de Teclado

Establezca los atajos de teclado personalizados.

Haga clic en Restablecer Atajo Predeterminado para restablecer el atajo seleccionado, haga
clicen [ x ] para eliminar el atajo seleccionado.

Para agregar mads atajos para una accion, haga clic en el boton [ +].

= Menu de Atajos del Teclado:

- Importar Atajos - Abre los atajos de teclado previamente guardados.

- Exportar Atajos - Guarde los atajos actuales como un archivo .xml personalizado.
- Restablecer Todos - Restablezca todos los atajos a los atajos predeterminados.

Haga clic en OK para confirmar los cambios realizados en Preferencias o Cancelar, si no lo
desea.

SUGERENCIA: Puede encontrar la lista de todos los atajos de teclado predeterminados en la

seccion Atajos de Teclado.
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Empezar a Pintar

Opciones del Flujo del Trabajo

Empezar una nueva pintura con el lienzo en blanco

1. Haga clic en Archivo > Nuevo... y una ventana de Nueva aparecera.

2. Establezca una anchura, una altura de la imagen, el color de fondo y DPI de imagen.

3. Elija el color del pincel, el gradiente o imagen desde el Panel de Paleta.

4. Elija una herramienta, el system de particulas, ajuste el tamafio del pincel y otros
pardmetros en el Panel de Propiedades y panel de Creador de Pinceles empiece a
pintar.

Empezar con una foto o una imagen de referencia

1. Haga clic en Archivo > Abrir... y elija su imagen de referencia.

2. Haga clic en Agregar Capa desde el panel de Capas para crear una capa nueva arriba de
la capa de referencia.

3. Elija una herramienta, el system de particulas, ajuste el tamafiio del pincel y otros
parametros en el Panel de Propiedades y panel de Creador de Pinceles empiece a
pintar.

Puede importar un dibujo o una foto de un software tercero en formato .png, .jpg, .bmp vy .tif
haciendo clic en Menu > Archivo > Importar... (File > Import...).

También puede arrastrar y soltar una imagen desde cualquier aplicacién o navegador de
Internet directamente a Flame Painter como una nueva capa.

Trabajar con Selecciones

En Flame Painter se puede seleccionar facilmente el area del lienzo para realizar operaciones
especificas sélo dentro de este drea seleccionada. Las selecciones sirven como herramientas de
enmascaramiento que bloquean las areas del lienzo que no desea cambiar.

Las operaciones que se pueden realizar en la seleccidn en Flame Painter incluyen pintar,
transformar, cortar, copiar y pegar.

Cuando una seleccidn esta activa, se dibuja en el lienzo con guiones. Todo lo que esta dentro
del drea delimitada esta seleccionado, todo lo que estd fuera no esta seleccionado.
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Pintrar dentro de seleccidon

Cree una mascara simple en el lienzo utilizando la herramienta de seleccién. Elija entre la
seleccion rectangular, eliptica, poligonal, a mano alzada o varita magica y cree la seleccion en el
lienzo. Usted pintara dentro de la seleccién, el area exterior permanecerad intacta. Para pintar
en las dreas fuera de la seleccién, haga clic en el botdn "Invertir seleccidon” l:l en el panel
Propiedades de la Seleccidn.

Nota: Puede ver rapidamente su seleccion actual mediante el botdn Mostrar Seleccion © en el
panel Capas. El drea no activa en el lienzo es de color rojo.

Transformar seleccion

Seleccione las partes especificas de su pintura usando la herramienta de seleccién. Para
transformar esta seleccién, haga clic en Transformar en el panel Herramientas o el atajo T/ Ctrl
+T/Cmd + T. Puede mover, escalar, rotar o voltear la seleccidn horizontal o verticalmente.

Se puede encontrar mas informacién sobre transformacién en la seccidon Propiedades de

Herramienta Transformar.

NOTA: Cuando se selecciona y transforma una parte de la pintura en la capa, la confirmacion de
la transformacion colocard el drea transformada en una nueva capa.
Cuando se selecciona y transforma toda la pintura en la capa, permanecerd en la misma capa.

Cortar, Copiar y Pegar seleccidn

Puede realizar funciones simples de cortar, copiar y pegar en el area seleccionada del lienzo
mediante el menu Editar o con los atajos de teclado.

Use Ctrl + X/ Cmd + X para cortar la seleccion y Ctrl + V / Cmd + V para pegar la seleccién.
Puede cortar y pegar también desde el menu Editar. Su seleccidn se pegara a una capa
separada.

Use Ctrl + C/ Cmd + C para copiar la seleccién y Ctrl + V / Cmd + V para pegar la seleccion.
También puede copiar y pegar desde el menu Editar. Su seleccidn se pegara a una capa
separada.
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Seleccionar todo / Deseleccionar todo

Seleccione el contenido de la capa actual con atajo Ctrl / Cmd + A o mediante el menu
Editar -> Seleccionar todo.

Deseleccione la seleccién actual con atajo Ctrl / Cmd + D atajo o mediante el menu
Editar -> Deseleccionar todo.

Se puede cambiar estos atajos en cualquier momento a través del panel

Preferencias -> Teclado -> Editar.

Invertir seleccion

Invierte la seleccidn actual. El area seleccionada se desactivara. Invierte seleccién usando
Ctrl / Cmd + Shift + | atajo o mediante el menu Editar -> Invertir seleccion.

Se puede cambiar el atajos en cualquier momento a través del panel

Preferencias -> Teclado -> Editar.

Trabajar con Regla y Perspectiva

Linea recta con la tecla Shift

La manera mds facil de pintar una linea recta en Flame Painter 4 es presionar la tecla 'Shift'
mientras se usa cualquier herramienta de dibujo. Presionando Shift establece un extremo de la
regla. Ajuste manualmente el otro extremo, presione el botén del ratén o una plumayy,
naturalmente, dibuje la linea entre estos dos puntos.

La herramienta se ajusta a la posicidn vertical y horizontal cuando esta cerca del angulo recto:
para desactivar esto, mantenga presionadas las teclas Shift + Ctrl (Shift + Cmd en macOS).

Herramienta Regla

Active la herramienta Regla desde el menu
Ruler Editar o presionando Shift + R.

La herramienta regla consiste en tres puntos de
Free Hand control. Vuelva a colocar la regla en el lienzo
haciendo clic y arrastrando el punto de control
Lock Control Points central sin cambiar el dngulo.
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A Mano Alzada - Active esta opcidén para dar a las lineas rectas un atractivo dibujado a mano.
Bloquear Puntos de Control - Bloquee los puntos de control de la regla para evitar que mueva

accidentalmente los puntos.

Herramienta Perspectiva

Active la herramienta Perspectiva desde el menu

Perspective Editar o presionando Shift + P.
Elija entre una, dos o tres puntos de
O One Point perspectiva.
(® Two Points ) .
O Three Points A Mano Alzada - Active esta opcidn para dar a

las lineas rectas un atractivo dibujado a mano.

Free Hand Bloquear Puntos de Control - Bloquee los

_ puntos de control de la regla para evitar que
Lock Control Points

mueva accidentalmente los puntos.

Lock Horizontally Bloquear Horizontalmente - Bloquee la

perspectiva horizontalmente.

Soporte Multitactil

El soporte multitactil estd disponible tanto para Windows y Mac O y ofrece un mayor apoyo
para las tabletas con pantallas tactiles y multitactiles. Puede desplazar, rotar y hacer zoom la
ventana grafica o la capa individual. Esto pofrece una forma sencilla y sensible de
posicionamiento y navegacion por el lienzo.

Use dos dedos para rotar y mover el lienzo al mismo tiempo,
moviéndolos en un movimiento circular mientras lo pasa
simultdneamete a través de la tableta. Al mismo tiempo se puede zoom
la ventana grafica apretando los dedos juntos o separandolos

Cuando los dedos estdn cerca uno del otro, puede mover el lienzo.

Puede habilitar o deshabilitar el soporte tactil en Flame Painter en Preferencias > Tableta. Es
posible habilitar / deshabilitar solo un toque con un dedo, o habilitar / deshabilitar el soporte
multitactil.
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Aqui también puede anular la seleccidn de la opcion "Usar para rotacidn de lienzo" si no desea
rotar el lienzo con dos dedos. El toque con dos dedos seguira funcionando para escalar y

mover.

Use un dedo para mover. Puede configurarlo en otra herramienta en
Panel de Preferencias > Teclado > Herramientas (mantener) y
configurarlo en "Toque con un dedo".

Importar & Exportar Formato Vectorial

Flame Painter 4 le permite importar un formato de archivo SVG a través del menu: Archivo>
Importar ...

Después de elegir el archivo que desea importar, seleccione si este archivo debe importarse
como:

Capa de mapa de bits: Las rutas de vector se importaran como una capa de mapa de bits. No
es posible editar mas esta capa como una capa vectorial.

Capa vectorial: Las rutas vectoriales se importaran como capas vectoriales. Cada ruta vectorial
se importard como una capa vectorial separada. Es posible editar alin mas estas capas a través
de la herramienta Editar capa vectorial.

NOTA: Cada ruta vectorial se importard en una capa vectorial separada. Por lo tanto,
recomendamos fusionar todas las rutas vectoriales antes de importar para obtener una
cantidad minima de capas vectoriales para una mejor edicion.

Flame Painter 4 le permite exportar la capa vectorial cuando esta con el renderizador Area (Fill)
en un formato de archivo SVG a través del menu: Archivo > Exportar capa a SVG...
Aqui puede configurar estos pardmetros:

Detalle - Determina la cantidad de detalles en el archivo .SVG exportado (1-5).
Detalle mas alto conserva mas de la forma original de la pintura, sin embargo el detalle mas
pequeiio es mucho mas simple. Para su posterior edicidn en un programa de edicién vectorial.

Forma de Superficie- Esta opcién afecta a la forma de los elementos de superficie.

La opcion predeterminada 'Cuadrado’ se aproxima a la forma de elementos a cuadrados y
conservas al maximo detalle. Las otras dos opciones pueden ser mds simple para posteriores
edicién, pero puede producir resultados significativamente diferentes que la pintura original.
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Opacidad - Esta configuracion determina la forma en que se maneja la opacidad de la obra de
arte completa.

‘Variable' - 1a aplicaciéon intentara automaticamente ajustar la opacidad de cada elemento de
superficie para que coincida con el trazo original con la mayor precisién posible.

'Uniforme’ - la opacidad de cada elemento de superficie se establece en valor constante (0-
100).

Contorno - Cuando habilitado, esta configuracién creara un contorno de ancho dado y
opacidad para aparecer alrededor de cada elemento de superficie diminuta que confecciona
toda la obra de arte exportada.

NOTA: La exportacion SVG estd disponible solo para trazos creados con el renderizador de

Arena (Fill). Los trazos pintados con pinceles de linea y el renderizador de linea punteada no se
pueden exportar como SVG.
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Flame Painter Connect - Photoshop Plug-in

Flame Painter Connect es un plug-in para Photoshop. Es un canal de comunicacién entre
Photoshop CC 2015-2020 y Flame Painter 4 para transferir capas entre estas aplicaciones.

Instalacion

Descargue Flame Painter Connect desde el correo electrénico que recibe después de la compra
o en cualquier momento desde su cuenta de la Comunidad.

Abra la carpeta Flame_Painter_Connect_1.3.1 > Flame Painter Connect PS_CC_2015-2020
En el menu principal de Photoshop, seleccione File > Scripts > Browse, y seleccione el archivo
"Installer.jsx".

Como ejecutar Flame Painter Connect

PASO 1: Ejecute Photoshop y Flame Painter 4.
PASO 2: En Photoshop, cree un nuevo documento
desde el menu: File > New...

PASO 3: En Photoshop, haga clic en el menu: Window
> Extensions > Flame Painter Connect. Aparece un
nuevo panel de Flame Painter Connect en el lado
derecho de la pantalla.

Cémo exportar capas

Exportar desde Photoshop a Flame Painter

Seleccione la capa que desea exportar a Flame Painter y haga clic en el botén “PS to FP”.

Si selecciona una capa vacia en Flame Painter, una capa de Photoshop se exportara a esta capa
vacia, de lo contrario, se creard una nueva capa.

Exportar desde Flame Painter a Photoshop

Seleccione la capa que desea exportar a Photoshop y haga clic en el botén "PS" en el panel
Capas, o en el menu: Capa > Exportar a Photoshop (acceso directo Ctrl+F para Win, Cmd+F para
Mac OS).
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Si selecciona una capa vacia en Photoshop, una capa de Flame Painter se exportard a esta capa
vacia, de lo contrario, se creara una nueva capa.

Las capas exportadas mantienen su nombre y opacidad originales. La mayoria de los modos de
fusidon también se conservaran.

Cémo mantener el mismo tamaiio de lienzo en Photoshop y Flame Painter 4
Opcidn 1: Ejecute Photoshop.
Cuando exporta la capa de Photoshop, la aplicacion Flame Painter se abrird con el tamafio de
capa exportada.
Opcion 2: Ejecute Photoshop y Flame Painter 4.
Cuando exporta la capa de Photoshop y hay un nuevo documento sin cambios en Flame
Painter, el tamafio de nuevo documento cambiara al tamano de capa exportada.
Opcidn 3: Ejecute Flame Painter 4 y Photoshop.
Abra Flame Painter Connect en Photoshop. Al exportar la capa de Flame Painter, el nuevo
documento se creard en Photoshop con el tamafno de capa exportado.
Opcidn 4: Establezca manualmente el mismo tamaiio del lienzo en ambas aplicaciones.

NOTA: En caso de que aparezca el siguiente mensaje mientras se trabaja con Flame Painter
Connect, verifique si tanto Flame Painter como Photoshop se estdn ejecutando.

It seems that Photoshop or Flame Painter Connect is not running.

Ensure that Photoshop is running on your system
and Flame Painter Connect plug-in is installed and running in Photoshop.

Si todo estd configurado correctamente, este mensaje puede aparecer mientras se exporta
desde Photoshop y significa que Photoshop tarda mucho en procesar la solicitud. Haga clic en
"OK" y espere unos segundos a que aparezca la imagen exportada en Flame Painter.
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Crear, Cargar y Guardar Pinturas

Crear Nueva Pintura

Para crear una nueva pintura, seleccione la opcion Nuevo... en el Menu de Archivo. Al hacer
esto, ventana de Nueva Pintura aparecera. Esta ventana le permite ajustar el tamafio de la
nueva pintura y configurar los ajustes del lienzo. En seccion "Informacion sobre Tamano de
Imagen” puede comprobar el tamafio de impresion de la imagen tales como anchura, alturay
DPL.

Seleccione el color de fondo, incluyendo la eleccion del preset del fondo Negro o Blanco.
Puede elegir un color de fondo Personalizado en la paleta de colores del sistema. Si necesita un
fondo transparente, establezca el color de fondo en Ninguno.

Finalmente, haga clic en OK para crear una nueva pintura o en Cancel si decide no hacerlo.
Abrir Pintura

Para abrir una pintura, seleccione la opcién Abrir... en el Menu de Archivo. Este panel le
permite abrir una imagen o ilustracion previamente guardada en el formato de archivo .fpa,
.psd, .png, .jpg, .bmp vy .tif como un nuevo projecto.

Finalmente, haga clic en OK para abrir una pintura o en Cancel si decide no hacerlo.

Para abrir una pintura recientemente guardada, seleccione la opcién Abrir Reciente en el
Menu de Archivo. Esta opcidn le permite seleccionar una de las ultimas pinturas.

Guardar Pintura

Para guardar la pintura, utilice la opcidon Guardar... en el Menu de Archivo. El formato nativo es
formato de archivo FPA, que contiene toda la informacién acerca de la pintura y las capas.
Utilice este formato si desea continuar con la pintura mas tarde. Le recomendamos que guarde
su trabajo periddicamente para evitar cualquier problema, mientras que acostumbrarse a un
nuevo software.
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Si desea guardar la pintura con los ajustes especificas o en forma que puede ser leida por otras
aplicaciones, utilice la opciéon Guardar Como... del Menu de Archivo. Le permite guardar la
pintura en el formato PSD, PNG, TIF, BMP o JPG. No es necesario fusionar capas para crear una
copia de su pintura para la impresion o para mostrar en la web. Las capas individuales se
guardan en formato de archivo FPA y PSD.

NOTA: Por favor, tenga en cuenta que solo el archivo FPA contiene toda la informacion de
imagen. Archivos PSD, PNG, TIF y BMP guardan solamente la informacion sobre el color y la
transparencia. La transparencia no se guarda en el formato JPG.

Con Flame Painter 4 puede abrir y guardar archivos .psd en capas para Photoshop, Gimp u
otros programas de mapas de bits que admitan el formato de archivo .psd, con todas las
configuraciones de capa, modos de fusidn y opacidad.

También es posible importar y exportar capas vectoriales como un archivo de formato

vectorial .svg desde / hacia Illustrator u otros editores de graficos vectoriales, donde puede
editar continuamente su imagen en vectores.

NOTA: La imagen vectorial exportada .svg puede verse diferente a la imagen original.

Finalmente, haga clic en OK para guardar una pintura o en Cancel si decide no hacerlo.

Guardar lterativo - Guarde versiones numeradas secuencialmente de una imagen. La primera
vez, " 1" se aflade al nombre del archivo. Posteriormente, cada vez el niUmero se incrementa
en 1y se crea un nuevo archivo numerados secuencialmente.

Guardar con Transparencia

Puede guardar su trabajo con un fondo transparente de Flame Painter ocultando la Capa de
fondo. Para ocultar el fondo, haga clic en 'Ojo' al lado de capa 'Fondo' en el panel Capas. Tal
trabajo se puede guardar en formato de archivo PNG con transparencia.
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Cerrar Aplicacion

Si desea cerrar una aplicacidn, se puede elegir entre las siguientes opciones dependiendo de su
sistema operativo:

Usuario de Windows Usuario de Mac OS
- haga click en Archivo > Quitar, o - haga click en Archivo -> Quitar, o
- presione un boton Cerrar en la esquina - presione un botdn Quitar en la esquina
superior derecha de una aplicacion o superior derecha de una aplicacion o
- utilice el atajo Ctrl+W, Ctrl+Q, Ctrl+F4 o - utilice el atajo Cmd+W, Cmd+Q o Cmd+F4

Alt+F4

NOTA: Por favor no se olvide de guardar su pintura antes de cerrar una aplicacion.
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Publicar Pintura a Galeria

Puede publicar una pintura en la Galeria directamente desde la aplicacidon Flame Painter o a
través del sitio web de Escape Motions Comunidad escapemotions.com/community.

Publicar desde Aplicacion

Vaya desde el menu de Flame Painter: Comunidad > Publicar. Establezca el nombre, las
descripciones y las etiquetas de la imagen y haga clic en el botdon Publicar. Su imagen se
publicara en la Galeria desde su cuenta de Comunidad.

Publicar desde Comunidad

Cuando compré Flame Painter 4, ingresé una contrasefia Unica: esta contrasefia se puede usar
para iniciar sesién en Escape Motions Comunidad. Vaya a escapemotions.com/community,

haga clic en login, ingrese su correo electrénico y contrasefia para Flame Painter 4.

NOTA: Puede encontrar su Correo Electrdnico en el menu de Flame Painter: Ayuda > Acerca de
Flame Painter.

Para publicar su pintura, vaya a My profile y haga clic en el icono Upload. Puede arrastrary
soltar sus archivos o cargar archivos desde su computadora. Seleccione el archivo que desea
cargar y haga clic en el botén Upload. Después de que termine la carga, ingrese el nombre de la
imagen, las etiquetas, la descripcion y seleccione el software en el que se creé. Para finalizar,
haga clic en Save.

Editar su Perfil de Comunidad y Pinturas en Galeria

En su perfil, haga clic en el botén Edit profile - puede editar su nombre de usuario, nombre y
apellido, cambiar la contrasefia, escribir una breve biografia y agregar sus cuentas sociales.
Si desea eliminar su cuenta, haga clic en "Delete my account" - se le enviara un correo
electrénico de confirmacién. Después de confirmar, su cuenta de Comunidad sera eliminada.

Para cargar o editar sus ilustraciones, haga clic en la pestafia Portfolio. Para acceder a los
enlaces de descarga de su software Escape Motions adquirido, vaya a la pestafia Purchases.
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Atajos de Teclado

Windows Mac OS
New... / Nuevo... Ctrl+N Cmd+N
Open... / Abrir... Ctrl+O Cmd+0O
Save / Guardar Ctrl+S Cmd+S
Save As... / Guardar Como... Ctrl+Shift+S Cmd+Shift+S
Iterative Save / Guardar Iterativo Ctrl+Alt+S Cmd+Alt+S
Import Image.../ Importar Imagen... Ctrl+Shift+O Cmd+Shift+O
Preferences / Preferencias Ctrl+, Cmd+,
Quit / Quitar Ctrl+W, Ctrl+Q, Cmd+W, Cmd+Q or
Ctrl+F4 or Alt+F4 Cmd+F4
Undo / Deshacer Ctrl+Z Cmd+Z
Redo / Rehacer Ctrl+Shift+Z Cmd+Shift+Z
Cut / Cortar Ctrl+X Cmd+X
Copy / Copiar Ctrl+C Cmd+C
Paste / Pegar Ctrl+V Cmd+V
Select All / Seleccionar Todo Ctrl+A Cmd+A
Deselect All / Deseleccionar Todo Ctrl+D Cmd+D
Invert Selecion / Invertir Seleccion Ctrl+Shift+l Cmd+Shift+l
Ruler Tool / Herramienta Regla Shift+R Shift+R
Perspective Tool / Herramienta Perspectiva Shift+P Shift+P
Draw Straight Line / Dibujar Linea Recta Shift Shift
Straight Line (no locking) Shift+Ctrl Shift+Ctrl
Brush / Pincel Q Q
Pen / Pluma A A
Eraser / Borrador E E
Fill / Relleno F F
Transform / Transformar T T
Edit Vector Layer / Editar Capa Vectorial Vv \"
Pick Color / Escoger Color Altor | Altor |
Selection / Seleccion M M
Image Size / Tamafio de Imagen Ctrl+Alt+l Cmd+Alt+l
Canvas Size / Tamario de Lienzo Ctrl+Alt+C Cmd+Alt+C
Lock proportions at scale /
Bloquear propociones a escala Shift Shift
Scale around center /
Escalar alrededor del centro Alt Alt
Lock rotation at 15 degrees /
Bloquear rotacién a 15 grados Shift Shift
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Increase Brush Size /
Aumentar Tamafio Pincel
Decrease Brush Size /
Disminuir Tamafio Pincel

Move Up / Mover hacia Arriba Up Up

Move Down / Mover hacia Abajo Down Down
Move Left / Mover a Izquierda Left Left

Move Right / Mover a Derecha Right Right
Move 10x Up / Mover hacia Arriba 10x Shift + Up Shift + Up
Move 10x Down / Mover hacia Abajo 10x  Shift + Down Shift + Down
Move 10x Left / Mover a lzquierda 10x Shift + Left Shift + Left
Move 10x Right / Mover a Derecha 10x Shift + Right Shift + Right
Move Layers Up /

Mover Capas hacia Arriba Ctrl+ [ Cmd + [
Move Layers Down /

Mover Capas hacia Abajo Ctrl +] Cmd +]
Select Prev Layer /

Seleccionar Capa Anterior Alt + [ Alt + [
Select Next Layer /

Seleccionar Capa Siguente Alt +] Alt +]
Merge Layers /

Fusionar Capas Ctrl+E Cmd+E
Clear Layer /

Limpiar Capa Del Del
Increase Value +1 / Aumentar el Valor +1  Up Up
Decrease Value -1 / Disminuir el Valor -1 Down Down
Increase Value +10 / Aumentar el Valor +10 Pg Up Pg Up
Decrease Value -10 / Disminuirel Valor -10 Pg Down Pg Down
Open Color Dialog / Abrir Dialégo de Color / /

Rotate Canvas / Rotar Lienzo R R

Move a Canvas / Mover Lienzo Botén derecho del ratén o Escpaciador + LMB

Exportar a Photoshop

Show | Hide All Panels /
Mostrar | Ocultar Paneles
Show Main Menu /
Mostrar Menu Principal

Zoom In / Aumentar
Zoom Out / Reducir

Ctrl+F

Tab
Ctrl+M

+,=, Ctrl + +
-, Ctrl + -
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Zoom 100% / Acercar 100% O/Ctrl+0 0/Cmd+0
Fit to Screen / Encajar en Pantalla

Zoom In | Out / Aumentar | Reducir Desplazamiento o Desplazamiento + Alt

Quit Hires Rendering /

Quitar Renderizador HiRes Esc Esc

Brillo / Contraste Ctrl+G Cmd+G
Matiz / Saturacidn Ctrl+U Cmd+U
Desaturar Ctrl+Shift+U Cmd+Shift+U
Invertir Ctrl+l Cmd+l

Show Safe Boundary /

Mostrar Frontera Segura Ctrl + B Cmd+B
Show | Hide Cursor /

Mostrar | Ocultar Cursor Shift + C Shift + C
Edit Tool /

Herramienta Editar 1 1

Group Edit Tool /

Herramienta Editar Grupo 2 2

Add & Remove Tool /

Herramienta Agregar & Eliminar 3 3

Init Curve Transform/

Transformar Curva Inicial 4 4

Help / Ayuda F1 Cmd+?

NOTA: Puede crear ajustes personalisados para esas y otras funciones desde el Menu: Editar >
Atajos de Teclado.

70



Derechos de Autor y Créditos

Flame Painter © 2012-2019 Escape Motions, s.r.o.
Flame Painter © 2009-2012 Peter Blaskovic
Flame Painter Connect © 2019 Escape Motions, s.r.o.

Escape Motions Equipo:

Peter Blaskovi¢, Michal Fapso, Miroslav Sedlak, Lubos Téth, Anton PoZivenec, Pavol Obuch,
Veronika Klimekova, Andrea Hornakova, Jaroslav Kasa, Pavol Valovic.

Agradecimientos especiales a:

Todos aquellos, que contribuyeron con ideas, sugerencias, o ayudaron a finalizar Flame Painter,
especialmente a Mehmet Yamanlar, Jeffrey Mangiat, Cindy Salvia, Frank Siekmann, Jason
McAllister, Virginia Soyka, Barb Brennan, David Antrobus, Gus Estevez, llona Strifler, Jonathan
Cope, Liiga Smilshkalne, Harvey Bunda, Oliver Wetter, Anastasea Zlatokryletz, Rana Dias, Scott
Kane, Emmanuel Charon, Matus Fedorko y Lubomir Zabadal.

Bibliotecas usadas:
Esta aplicacién ha sido desarrollada con las siguientes bibliotecas:

Qt 5.10, LGPL License - https://www.qt.io/download

QuaZIP, LGPL License - http://sourceforge.net/projects/quazip/

ImageMagick, Apache License - http://www.imagemagick.org/

AntiGrain Geometry 2.4, LGPL License - http://agg.sourceforge.net/antigrain.com/index.htmi
Boost 1.66, Boost Software License 1.0 - https://www.boost.org

Catch2, Boost Software License 1.0 - https://github.com/catchorg/Catch?2

GCC OpenMP Library, GPL License with GCC Runtime Library Exception -
https://gcc.gnu.org/projects/gomp/

libsimdpp, Boost Software License 1.0 - https://github.com/p12tic/libsimdpp
LibXML2, MIT License - http://www.xmlsoft.org/

Svg++, Boost Software License 1.0 - https://github.com/svgpp/svgpp

Composable futures C++ library, MIT License - https://github.com/rpz80/cf
micro-ecc, BSD 2-Clause Simplified License - https://github.com/kmackay/micro-ecc
mbedtls, Apache 2.0 License - https://github.com/ARMmbed/mbedtls
better-enums, BSD 2-clause license - https://github.com/aantron/better-enums

Gracias a Dios por todas las ideas creativas.
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Flame Painter End-User Software License Agreement

Copyright 2012-2020 Escape Motions, s.r.o. All Rights Reserved.
Copyright 2009-2012 Peter Blaskovic. All Rights Reserved.

This license is a legal agreement between you and Escape Motions for the use of Flame Painter
software (the "Software"). By downloading, installing, copying, or otherwise using the
Software, you acknowledge that you have read terms and conditions of this license,
understand them, and agree to be bound by them. If you do not agree with these terms and
conditions, Escape Motions is unwilling to license the Software to you, and you are not
authorized and may not use the Software.

Permitted Use

You are licensed to use the Software as expressly set out in this Licence from your first use of
the Software until termination of this Licence. The Licence granted to you is limited, non-
transferable and non-exclusive. Except to the extent any rights cannot be excluded by law, you
are permitted:

Demo Mode

to download, install only the number of copies of the Demo Software required for the
evaluation. Users evaluating the Software in demo mode ("Demo Software") may use the
Software only for personal, non-commercial internal use.

The Software in Demo mode is a free evaluation version of the software. It is made available to
you solely for the purpose of demonstrating the program capabilities of the software. It may
not include the full functionality found in the full version.

Full License

(i) if you are a private individual, to download, install three (3) copies of the Software directly
on a computer running Microsoft Windows (“Windows Computer”) or macOS ("Mac
Computer") that you personally own or control provided that not more than one of those
computers is in use simultaneously.

(i) if you are a commercial enterprise, to download, install, use and run one (1) copy of the
Software for use by one individual or multiple individuals on a single shared Windows or Mac
Computer that you own or control. For example, multiple employees may serially use the
Software on a single computer used as a shared resource.

Users of the Flame Painter Full License may use the Software for commercial, or for-profit
activities as well as for personal, non-commercial, or non-profit activities.
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You may not remove the copyrights notices from the Software. You may make one (1) copy of
the Software for back-up or archival purposes.

Restrictions

This is a SINGLE COPY SOFTWARE LICENSE. The Software is copyrighted and protected by law
and international treaty. This is a license, not a transfer of title, and unless you have been
granted prior, written consent from Escape Motions you may not:

a, Reproduce, distribute, or transfer the Software, or portions thereof, to any third party.

b, Sell, rent, lease, assign, or sublet the Software or portions thereof.

¢, Grant rights to any other person.

d, Modify, decompile, reverse engineer, disassemble, or create derivative works based on the
Software or the documentation in whole or in part.

e, Use the Software in violation of any international law or regulation.

You must not intentionally or unintentionally make the Software available on any web server,
ftp server, file sharing network, shared directory, or other location where any other person can
acquire a copy of the Software. You are responsible for keeping the Software safe from being
copied by others.

Display of Copyright Notices

All copyright and proprietary notices and logos within the Software files must remain intact.

Indemnity

You agree to indemnify and hold harmless Escape Motions for any third-party claims, actions or
suits, as well as any related expenses, liabilities, damages, settlements or fees arising from your
use or misuse of the Software, or a violation of any terms of this license.

The Software may contain technical inaccuracies or typographical errors, so changes and/or
updates may be affected without notice.

Peter Blaskovic may also make improvements and/or other changes to the Software at any
time without notice.

Disclaimer Of Warranty

THE SOFTWARE IS PROVIDED \"AS IS\", WITHOUT WARRANTY OF ANY KIND, EXPRESSED OR
IMPLIED, AS TO THE SOFTWARE OR ITS OPERATION, INCLUDING, BUT NOT LIMITED TO,
WARRANTIES OF QUALITY, PERFORMANCE, NON-INFRINGEMENT, MERCHANTABILITY, OR
FITNESS FOR A PARTICULAR PURPOSE. FURTHER, PETER BLASKOVIC DOES NOT WARRANT THAT
THE SOFTWARE OR ANY RELATED SERVICE WILL ALWAYS BE AVAILABLE.
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Limitations Of Liability

YOU ASSUME ALL RISK ASSOCIATED WITH THE INSTALLATION AND USE OF THE SOFTWARE. IN
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS OF THE SOFTWARE BE LIABLE FOR
CLAIMS, DAMAGES OR OTHER LIABILITY ARISING FROM, OUT OF, OR IN CONNECTION WITH
THE SOFTWARE. LICENSE HOLDERS ARE SOLELY RESPONSIBLE FOR DETERMINING THE
APPROPRIATENESS OF USE AND ASSUME ALL RISKS ASSOCIATED WITH ITS USE, INCLUDING
BUT NOT LIMITED TO THE RISKS OF PROGRAM ERRORS, DAMAGE TO EQUIPMENT, ANY LOST
PROFITS, BUSINESS INTERRUPTION, LOSS OF DATA OR SOFTWARE PROGRAMS, OR
UNAVAILABILITY OR INTERRUPTION OF OPERATIONS.
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